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Disclaimer

This book, "Windows 11 SENIORS GUIDE” contains content that is only meant for
general educational purposes. The publisher and author disclaim all explicit and
implied claims and guarantees on the availability, appropriateness, correctness,
completeness, and reliability of the information included therein.

The author's understanding and interpretation of Windows 11 features forms the
basis for the instructions and suggestions provided in this book. Because
software updates and technology are ever-evolving, it is crucial for readers to
double-check information using the most recent official Microsoft resources or
other trustworthy sources.

When using the hints, techniques, and secrets provided in this handbook,
readers are urged to use caution and good judgment. For any loss, harm, or
damage resulting from the use or misuse of the material included in this book,
the author and publisher disclaim all liability.

Microsoft Corporation owns the trademarks for Windows, Microsoft, and the
Windows logo. Microsoft Corporation is not associated with or endorsing this
tutorial. All product names, logos, brands, and other trademarks that appear in
this book or are mentioned in it belong to the owners of such trademarks. These
trademark owners have no connection to the writer or publisher and do not
approve of this manual.

Any mistakes or omissions in this book, as well as any outcomes from using the
material provided, are not the responsibility of the author or publisher. The
information in this guide may change at any time without prior notice, and
neither the publisher nor the author are required to update the material to
reflect such changes.

Readers who use this guide agree to release, indemnify, and hold harmless the
publisher, author, and any contributors from any claims, liabilities, losses,
damages, or costs resulting from or connected to the use of or reliance on the
information included in this book.

It is highly advised that readers look for the most accurate and recent
information on Windows 11 by using Microsoft's official documentation and
support sites.
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WINDOWS 11 DOWNLOAD AND
INSTALLATION ON YOUR PC

Even though Windows 11 has been out for a while, Windows
10 users may still update to the new operating system for
free via Microsoft. Compared to Windows 10, Windows 11
has a ton of new features that make it worthwhile to
acquire. It's also not a little version. However, if you run into
trouble and are unsure how to download Windows 11, we
have you covered.

DIFFICULTY LEVEL: MODERATE
TIME ALLOWED: 15 MINUTES

WHAT YOU'LL NEED: A Windows 10 PC, internet access, and
an optional USB drive.

Windows 11 may now be downloaded and installed using
five main ways. The best course of action is to wait for your
computer's Windows Update to make it accessible for free.
The second way is to use the Installation Assistant to force
your PC to download it. Utilizing the Windows Insider
Program is the third option. There is no file or data loss with




these three ways. The media creation tool is your fourth
choice. Alternatively, you may utilize an ISO file of Windows
11 to manually clean install the operating system on your
computer as your fifth option. You will lose files with these
two procedures since they need a clean install. They serve
as a last option.

Just remember that in order to get Windows 11, your system
specs must match. If not, you may modify your installation
to make it work, but doing so can stop Microsoft updates
from coming to your computer. We advise use the PC Health
Check tool to make sure your machine is Windows 11
compatible before moving forward.

How to Install via Windows Update

The easiest method to get Windows 11 is via Windows
Update. You will get a Windows update notification when it is
prepared for your computer. Proceed with the installation by



completing these steps. You will not lose any files or data on
your computer if you choose this option.

Step 1: Go to Settings > Security and updates. Choose
Check for updates after that.

Step 2: A prompt to update to Windows 11, which is free,
ought to appear. To accept the conditions, click the Accept
and install button after selecting the blue "Download and
install" option.

Step 3: Now that Windows Update is open, the Upgrade to
Windows 11 should show up with a download progress bar
and percentage. Please give it time to end.

Step 4: Now that Windows Update is open, the Upgrade to
Windows 11 should show up with a download progress bar
and percentage. Please give it time to end.

How to Use the Installation Assistant to Install

Use the Windows 11 Installation Assistant if Windows
Update isn't able to install Windows 11. By doing this, you
may manually update from Windows 10 to the most recent
version of the OS. Once again, you have to make sure that
your computer meets Microsoft's minimum requirements




before using this approach. Additionally, no data will be lost.
That's how.

Step 1: Visit the Windows 11 download page from Microsoft.
Locate the Windows 11 Installation Assistant option from the
menu bar and choose it by clicking the blue "Download
now" button.

Step 2: Wait for the program to finish downloading. Run it
when you're done. When asked, answer "yes."

Step 3: Accept and install should be selected in the pop-up
box. From now on, there will be three steps in the
procedure. First, you'll need to wait for Windows 11 to
download. Your internet speed may determine how long it
takes. It can ask you to agree to the terms of service
provided by Microsoft.

phase 4: Windows 11 will check the integrity of the
download in the second phase. It ought to take only a little
while.

stage 5: You will be requested to install Windows 11 in the
background in the third stage. After letting it install, just
wait. Depending on your PC's speed, it can take a while, but
no more than 30 minutes.
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Step 6: When the third stage is finished, choose Restart
immediately. Notification of your impending unsigning will
be sent to you. When your machine restarts, wait for
Windows 11 to install. It may take as long as thirty minutes
or an hour, depending on the age and performance of your
CPU and computer.

Step 7: The notification "Working on updates" will appear
while Windows 11 is installed. A percentage of the progress
will be shown. Your computer will restart itself multiple
times; please be patient. After it's done, the Windows 11
desktop will appear, then the sign-in screen.

Using Windows Insider Program to Install

If the previous two ways don't work, you may install
Windows 11 via the Windows Insider Program. This is a last-
ditch attempt since the Windows Insider Program will install
unstable, still-in-preview versions of Windows 11 on your
computer.

Step 1: Select Windows Insider Program under Update &
Security under Settings. Connect your Microsoft Account
after that.



If you're new to the Windows Insider Program, you'll see that
there are three channels: development, beta, and release
preview. Windows 11 is currently being tested in the Dev
and Beta channels. Decide which is best for you.

Step 2: One of the most reliable testing settings for
Windows 11 is the beta channel. If you decide to subscribe
to this channel, you will experience fewer glitches and
issues. But keep in mind that the beta channel will only be
made available on rare occasion.

You'll need to subscribe to the dev channel in order to get
Microsoft's latest versions of Windows 11, which include
weekly updates and all of the new features. In the
meanwhile, you may get a first look at the next Windows 10
release by using the Release Preview.

Step 3: Verify your choice of channel once you've selected
one that seems reliable. You will be prompted to check in
with a Microsoft account if you haven't already. After that,
your computer will restart.

Step 4: Go to Settings > Update and security when your
machine has rebooted. Return later to see any changes.
There will be a list for Windows 11. Choose "Download and




install," then watch as the operating system installs on your
device!

How to Perform a Clean Installation with
Windows 11 Installation Media

Windows 11 may also be installed via Installation Media.
This tutorial will show you how to create a bootable USB
stick that you can use to securely install Windows 11 on a
different device or your existing Windows 10 computer.
Because this method will erase all of your data, we strongly
discourage doing it. To get this option, visit the Windows 11
Download Page if you understand the danger. Select the
Windows 11 installation media creation option. then adhere
to the guidelines listed below.

Step 1: To accept the conditions, click Accept. After letting
the Setup process finish, choose Use the suggested settings
for this PC. It allows you to choose a USB flash drive by
choosing Next.

Step 2: Click Next after choosing your USB flash drive from
the list. Windows 11 will start to download upon request.
The installer will proceed to the next stage, which is making
Windows 11 installation disks, when the installation is
complete. You'll get an alert when the drive is prepared.




Step 3: Select Finish to close the program when your USB
device is ready. Maintain the connection between the USB
drive and your PC,

Choose an option

Troubleshoot
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Step 4: Go back to the Windows 10 settings app, then
choose Security and Update. Then choose Recovery from
the menu on the left. Under Advanced startup, choose
Restart immediately.

Step 5: Choose Select a gadget from the pop-up menu. You
should see your USB flash drive listed. Windows will
restart your USB drive and the Windows 11 installation when
you choose it. If your BIOS or UEFI does not include this
option, you will need to manually boot from the USB disk.
Occasionally, you may do this by hitting F12 as soon as your
computer turns on. For further information, speak with your
computer's manufacturer or refer to the online manual.

Step 6: Select a language once you're within the Windows
11 setup, then click Next. Choose the Windows 11 version
that matches the Windows 10 version on your PC. and after
that select Next.



Step 7: Choose the drive to install Windows 11 and the
Custom option. To remove all of the files from the device,
you might need to utilize the Format button. Click Next after
selecting the drive once again when you're done.

Step 8: Your PC will install Windows 11, at which point you
may unwind. After that, you'll be sent back to Windows' first
setup screen and asked to restart it.




How to Undertake a Manual Clean Install of
Windows 11 ISO File (not recommended)

The third, and most drastic, way to install Windows 11 is by
using an ISO file. This is for methods when the procedures in
the previous section don't work. But be aware that utilizing
this file will need you to reinstall Windows 11 and wipe your
hard drive. Make a backup of everything as a result. This ISO
may also be used to install Windows 11 in a virtual machine.
It is addressed in a different guide.

Step 1: Click the Download Windows 11 Disk Image button
after navigating to the Windows 11 download page. Once
you've chosen Windows 11 multi-edition ISO from the list,
click the blue Download button. After selecting English as
your language, click the blue "Confirm" button.

Step 2: After downloading the package, you'll need to
download a few more files to finish installing Windows 11
completely. We suggest Rufus, a fantastic tool for creating a
Windows 11 installation disk that can be booted.

Step 3: Visit the Rufus website to get the download. Open
the file, then click Yes. Next, select an empty USB drive by
inserting it under Device. Verify whether the smartphone's
storage capacity exceeds 8GB.

Step 4: Choose an ISO image or a disk from the Boot menu.
After that, to make your choice, click the Select button. Click
Open once you've found the location where you saved the
Windows 11 ISO file.

Step 5: Choose the Windows 11 Standard installation or the
Windows 11 Extended installation. If your computer meets
the criteria, the Standard Windows 11 Installation is your
best bet. You can attempt the extended option if it doesn't
work to get over Microsoft's restrictions. After leaving
everything else alone, select Create Drive.

Step 6: The USB disk will be prepared in a little while. When
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Rufus is done, restart your computer and install Windows 11
by following the instructions in the preceding section.



SHOULD YOU RUN WINDOWS
11?

Since Windows 11 is the most latest version, it is generally
the best option for most users. Its new capabilities do,
however, have some serious limitations that make some
upgrades more challenging, especially on older PCs.

Cycle of support and updates

Windows 11 abandoned Windows 10's semi-annual update
schedule in favor of a single annual release. That's exactly
how macOS operates. Microsoft has said that it would only
provide upgrades for Windows 10 once a year and that it
will maintain the operating system until 2025. Beyond the
big annual release, Windows 11 gets incremental feature
rollouts throughout the year.

The latest Windows 11 2022 Update sets the standard for
these yearly updates. It has an abundance of capabilities,
particularly when compared to the sluggish pace of
Windows 10 improvements.

This update contains everything from brand-new
applications like Clipchamp to little tweaks to the Start
menu. several users need accessibility features, and
Windows 11 finally includes several essential Windows 10
features like Start menu folders. It seems to be the Windows
11 version that ought to have been launched last year in
many respects.

Bugs

While Windows 10 is significantly older and more reliable
than Windows 11, Windows 11 has had its share of issues.
On the other hand, Microsoft has responded swiftly to issues
with its present operating system. We've discovered two



issues with File Explorer: one that causes hundreds of empty
folders to be created, and the other that noticeably reduces
SSD performance.

Microsoft already issued a warning about installing one of its
Windows 11 upgrades, and AMD CPUs have frequently
caused issues for the operating system. Even though
Microsoft has fixed every issue, it is reasonable to assume
that Windows 11 will still have more bugs than Windows 10,
even if Microsoft fixes them quickly.

However, there is now a memory leak problem with
Windows 11. Running several File Explorer instances in
Windows 11 may require more Memory. When the File
Explorer is closed, the RAM is never released, resulting in
increased system resource utilization. This is a notable issue
even if it isn't a common one and has also been present in
Windows 10 for some time.

Even though we've previously discussed a few Windows 11
problems, there's a fantastic method to monitor bugs in this
edition of the operating system. Users of Windows may
always report new flaws by using the Feedback Hub
application. Sorted by New or Top, you may see every small
Windows 11 problem that we were unable to fix in one




article. If you really want to know what's going on, search
for Windows 11 feedback in the app on your Windows 10
computer.

Is upgrading to Windows 11 worth it?

The majority of people ought to switch to Windows 11. It
offers a ton of updated designs, performance
improvements, and new features. It usually gets more
attention than Windows 10 because it's the most recent
version of the Windows operating system.

There is some risk involved with upgrading to Windows 11.
You may easily remove Windows 11 and go back to Windows
10 with a little planning. Furthermore, now that the most
recent update is accessible, there has never been a better
opportunity to give it a try.



WIDGETS ON WINDOWS 11

One of the best things about Windows 11 is its widgets.
Widgets allow you to see some of your most critical
information in a condensed area on the side of your desktop
without ever opening an app or using your phone. You may
access it at any time by clicking on the weather symbol by
hovering your cursor over the left side of the Taskbar or by
hitting the Windows Key and W on your keyboard. Then, you
can add additional widgets by using the Add widgets button.
Additionally, you will be able to add and rearrange several
widgets. Unlike Windows Vista and Windows 7, Microsoft
does not presently support third-party widgets in Windows
11. Still accessible, though, are a number of top-notch
official Microsoft widgets and a third-party widget choice.

These are a few of the best Windows 11 widgets available
for purchase at this time.

I — — I

Weather Widget

At the top of our list is Windows 11's weather widget.
Because it allows you to choose a specific place to display
the weather or use your current location, this is one of the
most customizable widgets. The three-dot Customize widget




option makes this feasible. The sizes that are offered include
small, medium, and big.

More weather data will be displayed with each size. Little is
a little card that just displays the weather at the moment.
On top of the existing circumstances, the medium size will
provide you with a five-day forecast in the interim. At last, a
line graph showing the hourly temperatures and the
likelihood of precipitation will be displayed on the huge
screen. Because it comes in three sizes, this is a great way
to check the weather without opening an app on your phone
or opening your web browser.

Sports Widget

A sports fan is someone who is always interested in the
performance of their team. There is a widget for that in
Windows 11, which is aptly named the sports widget. This
widget offers a wide range of modification and size options,
much like the weather widgets. A range of sports are also
available for selection.

Major sports leagues including the MLB, NHL, NBA, NCAA,
and others are supported by this widget. You may add one
of these leagues or a single club from the league to the
widget by choosing the three-dot customize widget option.
When you add a league, the schedule for the league or




team will be shown. The number of results in your widget
will rise if you pick Small, Medium, and Large.

o Outlook Calendar
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Outlook Calendar Widget

Now that working from home is more widespread than ever,
you may be hosting more virtual meetings. You will thus
need to keep track of meeting times on a calendar. On
Windows 11, there's an Outlook widget for that. When
added, it shows the month that is currently in effect along
with any scheduled daily activities. Additionally, you may
use the widget to create an event and link to your web
browser. Try experimenting with the different widths; they
will give your widget access to more preview days of the
week.



Photos

On this day

Onedrive Photos Widgets

On our list of the best Windows 11 widgets, the OneDrive
Photos widget comes in last. This widget will, as its name
suggests, show you a selection of the photos stored in your
OneDrive account and then instantly take you to the
OneDrive website so you can see the rest. You can see all of
your favorite pictures from past years in one easy location.



This one only comes in two sizes, medium and small, unlike
the others on our list. Remember this.

Adding Third-Party
Widgets

Everything on our list up to this point has been a Microsoft-
approved widget that is compatible with Windows 11
widgets. On the other hand, you may expand your options
by adding third-party widgets to Windows 11's desktop and
other areas.

This can be done with a number of fantastic tools that bring
back the original look and feel of Windows Vista or Windows
7, where widgets are shown on the right side of your
desktop.

Our number one pick is the Widget Launcher App for
Windows 11, which is free. This application will customize
your desktop with a conversion widget, sticky notes, and a
CPU monitor. You may also adjust the transparency and
color of these widgets. Other third-party programs that can
add widgets to Windows 11 include ClocX, a clock widget;



Crypto Price Widget, which tracks cryptocurrencies on your
desktop; and Desktop Ticker, which adds an RSS feed to
your desktop as a scrollable ticker. Just keep in mind that
since most of these are legacy programs for previous
iterations of Windows, they might not function correctly on
Windows 11.



CUSTOMIZING THE LOOK AND
FEEL

Windows 11 has a lot of customizable options that allow you
to quickly refresh the feel to avoid having the same
appearance every day or alter the design and other
elements of the desktop to make the experience more
unique.

You have the option to switch the desktop background to a
Microsoft Store theme or a picture of yourself. You may
change the desktop's background color to a personalized
accent color or switch between bright and dark color
settings. You may organize your favorite apps into folders on
the Start menu. Along with many other customization
options, you may change the system tray settings, the
Taskbar's orientation, and which things show up in the
interface.

This following sections will walk you through the several
ways to customize your computer's look and feel more like
you.

How to Change the
Background Color in
Windows 11

Making a slideshow, choosing a solid background color, or
altering the background picture are the easiest ways to
customize the look of your Windows 11 desktop. You may
now choose a different backdrop for each desktop if you
utilize the virtual desktop feature.

Alter your desktop wallpaper



Personalization

Use these procedures to modify the desktop wallpaper on
Windows 11:

Go to the option that says Settings.
Choose Customization.
Click on the Background page on the right.

From the "Personalize your backdrop” menu, choose Picture.
Choose the option to Browse photos.

Select a desktop background image.

Click the Choose image button to pick a picture.



(Optional) To ensure that the image fits the screen, choose
the Fill option in the Choose a fit for your desktop image
selection. Additional choices are Center, Span, Fit, Stretch,
and Tile.

As an alternative, you may set an image as your desktop
background by right-clicking on it and selecting Set as
desktop wallpaper.

Creating a desktop
slideshow

Use these methods to make a slideshow on your desktop:
Go to the option that indicates Settings.

Choose Customization.

Click on the Background page on the right.

From the "Personalize your background" menu, choose
Slideshow.

Choose the Browse menu item.



Select which image folder you want to see on your desktop.
Click the button to choose this folder.

Use the Change picture every option to choose how often to
rotate photographs. There are one, six, or one day as well as
one, ten, or thirty minutes as options.

(Optional) Turn on the toggle for "Shuffle Picture Order."

(Details optional) To ensure that the image fits the screen,
choose the Fill option in the Choose a fit for your desktop
image setting. Additional choices are Center, Span, Fit,
Stretch, and Tile.

Once the steps are complete, the desktop will rotate the
backdrop picture collection at the intervals you choose in
the preferences.




Setting the desktop to a solid color.

To add a solid color to the Windows 11 desktop, follow these
steps:

Go to the option that indicates Settings.
Choose Customization.
Click on the Background page on the right.

From the "Personalize your backdrop" menu, choose Solid as
your color option.

Select a color for the backdrop.
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(Optional) Select the View colors button from the "Custom
colors" menu.

Make a unique color.
Click the Done button.

When you follow the directions, the desktop backdrop will
be a solid color.




Setting the background
for each desktop.

With Windows 11, you can now customize the backdrop of
each virtual desktop to make it easier for you to tell them
apart.

To change the wallpaper on each desktop (not monitor),
follow these steps:

Go to the option that says Settings.
Choose Customization.
Click on the Background page on the right.

From the "Personalize your backdrop” menu, choose Picture.

Right-click the image and select Set for desktop to apply the
backdrop.

Each virtual desktop will have a different desktop wallpaper
once you've completed the tasks.



different
background for each
display.

Every monitor's backdrop image may be altered as well.
This option won't be available while utilizing virtual
desktops, though.

In order to set a unique backdrop for every monitor in
Windows 11, take the following actions:

Go to the option that reads Settings.




Choose Customization.
Click the Background page on the right.

From the "Personalize your backdrop” menu, choose Picture.
To set the picture on a monitor (N), right-click on it.

It might be necessary for you to repeat the steps once more
in order to apply a different image on the remaining
displays.

Changing the colors In
Windows 11

With Windows 11, you may change the color of everything
on your desktop. You have the option to select a custom
accent color that will show up on the Start menu, Taskbar,
Notification Center, Quick Settings, title bars, borders, and
applications in addition to utilizing the bright or dark modes.

Setting the color mode to
light or dark.

Use these procedures to switch between Windows 11's dark



and light themes:

Go to the option that says Settings.
Choose Customization.

Click on the Background page on the right.

From the "Choose your mode" option, choose between the
Light and Dark color modes.

The desktop environment, which includes the Taskbar, Start
menu, and applications, will change to the color choice you
choose once you've completed the steps.

Adjust the color mode.




To activate a custom system color mode, take the following
actions:

Select the Settings option.
Choose Customization.
Click on the Background page on the right.

From the Choose your mode menu, choose Custom color
mode.

To choose between bright and dark mode for the Start,
Taskbar, and other components, select your normal
Windows mode.



utilize the Choose your default app mode setting to decide
whether applications should utilize the bright or dark color
choice.

Depending on your selections, Windows 11 will use the
custom color mode when the procedures are finished.

Enabling or disabling the
Transparency effect.

Semi-transparency effects can be shown by several
features, such as the Taskbar, Notification Center, Start
menu, Quick Settings, and apps. You can utilize or disable
these effects under the "Colors" tab.

In Windows 11, do the following actions to activate the
transparent effect:

Go to the option that says Settings.
Choose Customization.

Open the Colors page by navigating to the right.



Toggle the Transparency effects toggle switch on or off after
selecting your mode.

After completing the procedures, you will be able to use the
selected transparency effects.

Setting a custom color accent

To customize the color accent in Windows 11, take the
following actions:

Go to the option that says Settings.
Choose Customization.
Open the Colors page by navigating to the right.



Under the "Accent color" setting, choose Manual.
Select a unique accent color.

(Details optional) Click the View colors button to see the
Custom colors option.

Create your own hue.
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Click the Done option.

(Optional) Use the "Accent color" setting and choose the
Automatic option to let the system choose a color based on
the colors of the desktop backdrop that is now shown.

The system icons, buttons, links, and many other
components will instantly change color when you follow the
instructions.

Displaying accent color In
the Start menu and
Taskbar

To make sure that the Start menu, Taskbar, Notification
Center, Quick Settings, and other components all have the
same color scheme, take the following actions:

Go to the option that says Settings.
Choose Customization.
Open the Colors page by navigating to the right.



Under the "Accent color" setting, choose Manual. A quick
tip: Selecting Automatic is another option.

Select a unique accent color.

Click the "Choose your mode" menu and choose either Dark
or Custom.

A little tip: Ensure that Dark is selected under "Choose your
default Windows mode" if you choose the custom option.




> Colors
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Make sure that the "Accent color" setting is turned on for
the taskbar and start screen.

(Optional) Turn on the Show accent color on title bars and
windows borders toggle switch (except in File Explorer) to
make the accent color visible in borders and title bars.

Once you're done, the color accent you select in the settings
will be applied to the Start menu, Taskbar, and other visual

components.

Displaying the accent
color on title bars and



borders.

To make accent color for title bars and borders visible, follow
these steps:

Go to the option that shows Settings.
Choose Customization.

Open the Colors page by navigating to the right.

Personalization

> Colors
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To make the accent color visible in borders and title bars,
click on the Show accent color on title bars as well as
windows borders toggle switch.

Once the steps are completed, the accent color will show up

in the program's title bars and border frames (not in File
Explorer).




How to Change Windows
11 Themes

An assortment of one or more background pictures, accent
hues, mouse pointer adjustments, and occasionally even
noises that may be obtained through the Microsoft Store is
called a theme (some are charged, others are free).

Altering the themes

To change the desktop theme, follow these steps:
Go to the option that says Settings.

Choose Customization.

Navigate to the Themes page on the right.

Under the "Current theme" setting, choose a theme from
the options.

Note: Windows 11 comes with six default themes: Windows
(light), Windows (dark), Glow, Sunrise, and Flow. Each
theme has a unique combination of wallpapers and settings.



To apply the theme to your computer, you need to follow
the instructions.

Download themes

To obtain fresh themes for your Windows 11 desktop, follow
these steps:

Go to the option that indicates Settings.
Choose Customization.
Go towards the Themes page on the right.




Under the "Current theme" option, click the Browse themes
icon.

Select the Windows 11 theme from the Microsoft Store.
Select the option to "Get (or Install)."

Choose the Open option.

Choose the recently installed theme to utilize it.

The freshly downloaded theme will show up on the desktop
and throughout the experience once you've completed the
instructions.



Contrast themes

Accessibility

Four distinct high contrast themes are included in Windows
11 as part of its accessibility features. These themes are
meant for those with low vision, although anybody can use
them.

Follow these procedures to use one of the contrast-themed
Windows 11 versions:

Navigate to the Settings option.
Select the option for accessibility.
Go to the page with contrast themes on the right.




Select a theme (such as "Aquatic") from the list of possible
themes under "Contrast themes."

Desert.
Dusk.
Night sky.

(Details optional) Press the keyboard combination Left Alt +
Left Shift + Print screen to enable or disable the contrast
theme.

After following the steps, Windows will launch with high
contrast.

How to Modify Windows
11's Start Menu

The Start menu, which is customizable in many ways and is
used to find and run applications as well as locate nearly
anything on your computer, including files, settings, and
programs, is a key component of Windows 11.

Changing the Start configuration



To modify the Windows 11 Start menu settings, take the
following actions:

Go to the option that says Settings.
Choose Customization.
Click the Start page icon on the right.

Turn on or off the "Show recently added apps" toggle.
Turn the toggle switch for "Show most used apps" on or off.

Turn on or off the option to display recently opened objects
in File Explorer, Jump Lists, and Start.

The items in the "Recommended" section and the "All apps"
list will appear in the Start menu when you activate the




recently added or most used applications selections.

Adding or removing Folders from the Start menu.

To add or delete quick access from the Start menu to other
destinations, such Documents, Downloads, and so forth, use
the following procedures:

Go to the option that indicates Settings.
Choose Customization.
Click the Start page icon on the right.

Select the Folders setting.



Turn on and off the things that show up next to the power
button in Start.

The fast access buttons will show up in the Start menu next
to the power button once you've completed the instructions.



Pin apps to the Start menu

To control the Pinned section of the Start menu, take the
following actions:

Launch the software.
Find the name of the application in Windows Search.
Right-click the application to choose Pin to Start.

(Optional) To move the app to the top-left corner, right-click
on it in the "Pinned" section and select Move to top.

(Optional) Drag the object within the "Pinned" area to the
appropriate location.

Right-click the program and select Unpin from Start or
Uninstall if you wish to remove it from the Pinned area.



Should the application originate from the Microsoft Store, it
will be removed without any more steps.

Should this be a classic software, you might have to follow
the prompts displayed on the screen in order to finish the
removal.

Customizing Recommended section on Start

The "Recommended" section displays suggestions for
previously visited files and installed programs. This section
may hold up to six items, but you can add more by clicking
the More button (if appropriate). Although this function
cannot be disabled, it can be made more pleasant.

ltems that have been suggested for removal should be
deleted.

Follow these procedures to remove items from the
Recommended section one at a time:

Begin the program.

Right-click the item in the "Recommended" column and
select the Remove from list option.

The item you selected will be removed from the Start menu
after the steps are complete.

Disable the part marked "Recommended.”



Personalization

To stop material from showing up in the Recommended
section, do the following actions:

Go to the option that says Settings.

Choose Customization.
Click the Start page icon on the right.

Personalization > Start

Disable the toggle option for "Show recently added apps."

Turn off the toggle for Show recently opened items in File
Explorer, Jump Lists, and Start.

Nothing will appear in the Recommended section after
you've finished the procedures. However, because you
disabled recently added applications and opened items, the
list of recently added programs will no longer be shown in



the File Explorer Quick access page, the Taskbar's Jump Lists
for apps, or the All apps list.

How to Personalize the
Taskbar in Windows 11

Although Windows 11's Taskbar isn't as customizable as
previous iterations, you can still modify a number of settings
to alter its appearance and feel. From the system tray, you
may change various settings, uninstall unnecessary system
components, and position things in different directions.

Modify the icons' orientation.



) Personalization
"

Follow these instructions to align the Taskbar buttons and
Start menu to the left:

Go to the option that indicates Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.

Select Taskbar Behaviors from the menu.

Choose the Left option under "Taskbar alignment" in the
options.




When you complete the steps, the Taskbar items, including
the Start menu, will be oriented to the left. If you want the
items to be centered, repeat the steps above, but on step 5,
pick the Center option.

Add or remove system app
icons

To modify the system app icons that show up next to the
Start menu, follow these steps:

Go to the option that says Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.




ion > Taskbar

The system app icons that you deactivated will no longer be
visible in the Taskbar when the actions are complete.

You can turn off
Search

Task view
Widgets

Chat

The system app icons that you deactivated will no longer be
visible in the Taskbar when the actions are complete.

Personalization

Insert or delete corner icons



To alter the icons that show up on the system tray, use the
following actions:

Go to the option that says Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.

Modify the "Taskbar corner icons" option to disable any
components—Ilike the Pen menu—that you do not want to
see in the system tray.

Use the touch keyboard.
Touchpad visualization.

Once the steps are complete, the system tray of the Taskbar
will display just the icons that you have enabled.



Personalization

Modifying the corner overflow settings

To show or hide objects from the Taskbar overflow, use
these steps:

Go to the option that says Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.

Use the "Taskbar corner overflow" option to disable the
application icons that you do not want to see in the system
tray, such as OneDrive, Microsoft Teams, and Windows
Update Status.



Only the things that have been enabled will show up outside
of the overflow flyout after the processes are complete.

Display Or Conceal App
Badges

To find out whether applications should provide badge
counts for unseen messages, follow these steps:

Go to the option that says Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.



Click on the Taskbar Behaviors menu item.

To enable or deactivate the unseen messages counter,
check or delete the Show badges (unread messages
counter) on taskbar programs option.

Click on the Taskbar Behaviors menu item.

Check or remove the Show badges (unread messages
counter) on taskbar applications option to activate or
disable the unseen messages counter.

As you move the mouse cursor away after completing the
instructions, the Taskbar will automatically disappear.

Display the Taskbar on all



monitors

To have the Taskbar appear on every monitor, follow these
steps:

Go to the option that reads Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.




Click on the Taskbar Behaviors menu item.
Check the option to show my taskbar on all monitors.

This option is limited to situations when your computer is
linked to many displays.

Turn on or off the desktop
button.

Use these methods to activate or disable Windows 11's
desktop display feature:

Go to the option that says Settings.
Choose Customization.
Choose Taskbar page from the menu on the right.




Click on the Taskbar Behaviors menu item.

Verify or disregard the selection Display the desktop at the
taskbar's far corner.

Once you've completed the instructions, the desktop show
and hide button in the Taskbar will no longer function.
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Settings flyout

To add or delete items from the Quick Settings flyout, use
the following actions:

Choose the volume and network settings.

Quick tip: Press the Windows key + A keyboard shortcut to
launch the flyout.

Choose the pencil-shaped Edit Quick Settings option.
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¥ Project

+/ Done + Add

Click the Add button.



Select the item that has to be added.

Use the Unpin symbol to take an item off of the list.

Click and drag an object to move it to the desired location.
Click the Done button.

Once the steps are complete, Quick Settings will show the
available choices in the order that you choose.

How to Change the Lock
Screen in Windows 11

In Windows 11, you may now customize the Lock screen,
which shows up anytime you need to access the Sign-in

page.

Setting custom Iimage on
Lock screen

To utilize a custom picture on the Lock screen, do the
following actions:

Go to the option that says Settings.
Choose Customization.




Click on the Lock screen page on the right.



From the "Personalize your lock screen" settings, choose the
Picture option.

Choose the option to Browse photos.
Select the personalized picture.
Click the Choose image button to choose a picture.

(Details optional) Take out the View engaging content,
shortcuts, and more on your lock screen.

The picture you choose in the settings will appear on the
lock screen after you've completed the steps.

Setting slideshow on Lock
screen

To use a custom slideshow on the Windows 11 lock screen,
do the following actions:




Go to the option that shows Settings.
Choose Customization.
Click on the Lock screen page on the right.

From the "Personalize your lock screen" settings, choose
Slideshow.

Choose the Browse menu item.

A little note: Windows 11 includes both the local and
OneDrive Pictures folders by default. To add new directories,
you may use these locations or remove them.

Select the folder that has every picture in it.
Click the Choose image button to choose a picture.
Click the button to choose this folder.

(Details optional) Take out the View engaging content,
shortcuts, and more on your lock screen.

Once the steps are completed, each time you start the
computer, the lock screen will rotate the photographs from
the folder you choose in the settings.

Configuring Windows
Spotlight on the lock



screen

The default Lock screen experience is Windows Spotlight;
however, if you were using anything other, or if you want to
reverse the changes, do these actions:

Go to the option that says Settings.
Choose Customization.
Click on the Lock screen page on the right.

From the "Personalize your lock screen" options, choose
Windows Spotlight.

After completing the instructions, each time you access the
Lock screen, you will see fresh images from Microsoft Bing.




Setting up app notifications on the lock screen.

To see app alerts on the Lock screen, adhere to following
instructions:

Go to the option that indicates Settings.
Choose Customization.
Click on the Lock screen page on the right.

To view the information you want to see, such the calendar,
mail, or weather, use the "Lock screen status" option.

Options to lock the current state of the screen

Upon completion of the steps, notifications from the
selected app will appear on the lock screen.



Disable background on Sign-in screen

In Windows 11, the Lock and Sign-in panels have the same
backdrop; however, if you want a solid color background,
you may disable this functionality.

To remove the backdrop of the Sign-in screen, follow these
steps:

Go to the option that says Settings.
Choose Customization.
Click on the Lock screen page on the right.

Deselect the Show the lock screen background image toggle
button on the sign-in screen.

The Sign-in screen will have a single-colored backdrop after
you've completed the steps.

Things in Windows 11 you
can't customize

Despite the fact that Windows 11 still allows you to
personalize its look and feel, many of the options from the



previous edition are no longer accessible.

Microsoft has taken out a number of useful and cosmetic
customization features from Windows 11.

Taskbar

It is no longer possible to move the Taskbar to the top or to
either side of the screen since it is now locked at the
bottom.

eliminates the ability to distinguish between different app
instances and show labels.

Removes the ability to drag and drop files for the currently
open program to open them.

The ability to enlarge or reduce the size of icons is gone.,
There is no longer a way to change the Taskbar's height.
Startup menu

Live tiles are no longer supported by the Start menu.
Resizing of the Drops menu is supported.

There is no longer a full-screen mode.

App groups can no longer be created.

It is no longer possible to arrange apps into folders.

WINDOWS 11 CUSTOMIZATION
TOOLS

These days, Windows 11 is widely accessible and preloaded
on new computers. The updated user interface, with the
Taskbar centered on the screen, is the first thing you'll
notice when updating or installing it, even if it increases
security:

What happens if you decide against wanting a new UlI? What
happens if you wish Windows 10 had looked more retro?



What happens if you prefer that the Start button be located
on the taskbar's left side? What happens if you only want to
tweak a few things?

This section will focus on six methods and tools for
personalizing Windows 1ll's appearance and feel. We'll
include a change toward the end to make Windows 10 seem
more like Windows 11 for folks who haven't updated yet.

1: Taskbar Configuration

Just right-click anywhere on the Taskbar and choose Taskbar
Settings to move the Start button back to its appropriate
place and move the Taskbar as a whole to the left.
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You'll see the taskbar personalization screen:

After you adjust the Taskbar's alignment to the left and
scroll down to observe Taskbar activities, you may enjoy the
previously comfortable Taskbar position.



2: PowerToys Operation

One of my favorite features is the ability to launch a search
window by pressing a key combination. | can now quickly
launch apps without having to go through menus thanks to
this.

Users of Windows 11 are eligible to get this feature for free.
It comes with the original PowerToys set. All you have to do
is press Alt and Space simultaneously once it is installed.
What you'll withess looks like this:

Let's say you then want to launch PowerShell or PowerPoint.
Simply enter "power":

g

power O
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PowerPoint -
m Application o O
Power Automate

Packaged applical

H PowerToys (Preview)
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F¥ Windows PowerShell ISE
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That's it. It is both simple and sophisticated. At first, | didn't
notice the omnipresent search box on the taskbar of
Windows 10. But this is a much quicker and more efficient
way to get to the apps you want to launch. It's a really easy
add-on that makes a big difference in the user experience.



3: Classic Context Menu iIn
Windows 11

In Windows 11, the default context menu has been
simplified. The menu is arranged as follows: an icon bar at
the top and an item labeled "Show more options" at the

bottom.



But with Windows 10, you might get a lot more information
by right-clicking on a picture. The Windows 11 Classic
Context Menu is useful in this situation. Your context menu
gets altered to show everything it used to, as shown below:

While there are certain Registry hacks that may bring back
the traditional context menu, messing with the Registry is
usually not advised. The person who created this
modification has included a little program that performs the
Registry changes on your behalf:

1””_

Enable Winl11 Classic Context Menu Style

Enable Win11 Default Context Menu Style

Restart Explorer Menu

One problem
exists. The first thing you see when you go to the
developer's website is a page full with what seems to be
spam. There are many of links and download buttons,
however most of them go to unidentified places due to
advertising. All you have to do is scroll down to the
download option, which is situated just above the Related
Posts section:



Afterward, confirm that you are getting W11ClassicMenu:



File name:  W11ClassicMeny < —

Save as type: Compressed (zipped) Folder

A Hide Folders Save Cancel

- Lastly, you
may have to tell Windows to bypass a few of its security
features so that you can install from an unidentified
publisher. Think about this carefully. How much do you really
desire that classic menu? Considering that you are going to
trust an unsigned executable with your life. | tried it, and
there were no unfavorable side effects; nonetheless, we
make no guarantees. You alone are in charge when it comes
to installing software downloaded from the Internet.
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4: Taskbarll

What comes next is a pretty simple software that lets you
customize the Windows 11 taskbar in a number of ways. As
you can see, in addition to allowing you to left-align the
taskbar, you can also adjust the size of the icons and move
it to the top of the screen—a feature that doesn't seem to
be included in Windows 11:

You may get the executable file from this Github repository.



5: Startll

We've concentrated on free methods of personalizing
Windows 11 so far. We are going to introduce you to two
tools that most Windows users will be familiar with.

Stardock began operations in 1991. Before switching to
Windows utilities in the late 1990s, when Windows emerged
as the most popular PC operating system, they started with
IBM's OS/2 platform.

For much of that time, they have been tweaking and
customizing Windows, but when Windows 8 changed
everyone's Start menu by deleting it, they began marketing
the required Start8 application. It turns out that, while not
as seriously, they also performed a Start 10.

While Startll performs most of what the previous
applications did, it does it in a more user-friendly way by
integrating all of the features. It may, for instance, move
your Taskbar to the left and return the menu to how it was
before:

You may try the following to get your Windows 11 PC to
display the previous version of the full-page, crowded
Windows Start menu:



Additionally, Startll will enable Windows 10 users who want
the appearance of Windows 11 but aren't ready to give up
Windows 10 access to that future user interface:

Startll is not free; Stardock charges $5.99 for it. Before
making a purchase, | advise you to download and test the
30-day trial version.

6: Fences



Fences is not a brand-new Windows 11 tool, in contrast to
everything else I've showed you. But when | want to change
mine, one of the first things | install is Fences since we're
changing the appearance and feel of your most recent
operating system.



It seems like fences were an easy notion. You may use it to
create frames on your desktop by grouping desktop icons
together. Every frame serves as a mini-window that you
may reposition and arrange. Here's an example:

Documents

2222332
22222

The feature that lets you roll up the mini-windows to quickly
access your icons while maintaining a neat desktop is what |
find most enjoyable:

Creating folder gateways with Fences is another one of my
favorite features.

This is an illustration of a OneDrive link, but I like to utilize
this feature for projects. | can see every project file on my

desktop even though | can keep them all sorted in a deep
folder on my NAS. It blends the best aspects of both worlds.

The most recent version, Fences 4, is in beta right now. It is



available for a 30-day trial period or may be bought for
$9.99.

There will be more to come.

Windows 11 will last a long time if previous major versions
are any guide (and there's no reason to think they aren't).
There will undoubtedly be an increasing number of Windows
11-specific tools available that provide for some very
intriguing customization.



USE THE TOP 20 WINDOWS 11
KEYBOARD SHORTCUTS TO
INCREASE YOUR PRODUCTIVITY

With Windows 11, you may spend all day navigating menus
or quickly get things done by pressing two or more keys at
once.

Although voice-to-text, touch displays, and other PC input
options are available, the keyboard remains the main
interface through which we interact with our computers. It
goes without saying that the majority of PCMag readers are
familiar with typical keyboard shortcuts, such as Alt-Tab for
window switching, Ctrl-C for copying, and Ctrl-V for pasting.
However, Windows 11 has a variety of powerful, little-known
key combinations, some of which involve the Windows key.
Throughout the day, | utilize a number of them rather
regularly.

Additionally, Windows special-function keys (which differ
based on the keyboard) may be used. Particularly useful are
the media keys, which provide mute, play/pause, and
volume. Apart from that, let's look at the most widely used
Windows 11 keyboard shortcuts.

The newly updated top 13 Windows 10 shortcuts will be
shown first, then the brand-new Windows 11 shortcuts.
(Pages 14-20).
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1. Take Screenshots with Windows Key-Shift-S

Pressing Windows Key-Shift-S will open the Snipping Tool
screen capture interface. It takes a screenshot of the full
screen, a window, or a drawn rectangle or freeform shape.
The option to alter and share the screenshot via an editing
window is shown in a notification panel. | use this method to
capture screenshots with Windows 11 at least twenty times
a day, but it's not the only one.
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2. Paste History with Windows Key-V

One of Windows' greatest features in the last 20 years,
Clipboard History, is launched with this key combination. You
may copy many things from a website or document and
paste them into another without having to travel back and
forth for each item by using the Clipboard History function.
It allows pictures and text to be copied to the clipboard. It's
important to note that in Windows 11, the resulting panel is
integrated with the keyboard shortcut I'll discuss next.

3. Special Characters
(Windows Key-.)



Emoji, special characters, symbols, and even GIFs that may
be typed with the cursor are shown in a panel via this
shortcut. | use it all the time to put en dashes and em
dashes. Greek letters, accented characters, and other
symbols not found on a standard US keyboard may also be
entered with its help. The most practical aspect of this tool
is that it makes your most often used symbols easily
accessible.

4. Windows Key-Tab: Task
View

Yes, you can still use Alt-Tab to switch between open
programs. After pressing the Alt key once, all active apps
will appear on the screen. To display the entire Task view,
use the Windows key flavor to expose each of your desktops
and the open programs on them. After that, programs may
be relocated from one desktop to another. Windows Key-Tab
helps me to shift personal programs like WhatsApp to the
proper desktop when they accidently show on my work
desktop, which is something | prefer to do.




5. Voice Typing (Windows
Key-H)

Voice Typing lets you type text with your voice instead of
your fingers by pressing the Windows Key-H. Any setting
where you would typically type may be used with voice
typing. You'll be shocked at how much better speech
recognition has grown if you haven't used it in a while. In
Windows 10, the shortcut still works, but the user interface
(Ul) has been made simpler. Since the H in this shorthand
stands for "hear," it is simple to remember.

6. Ctrl-Windows-Left/Right
Arrow: Switch Desktop

In Windows 11, you may quickly switch between virtual
desktops by pressing Ctrl-Windows Key-Left/Right Arrow. On
my desktop, | use this one every day. The same may be
done with a laptop trackpad by swiping four fingers left or
right.




7. Display the Desktop
with Windows Key-D

To see the bare desktop, use Windows Key-D. When you
wish to start again with a blank slate and your screen is
cluttered with program windows, this is helpful. To get the
same result, you may also activate desktop peek, which lets
you move your cursor to the bottom-right corner of the
screen.

8. Task Manager (Ctrl-
Shift-Esc)

The Task Manager may be opened using this keyboard
shortcut, which dates back to the early days of Windows.
When your computer seems slow and you want to discover
which program is using up RAM or CPU cycles, it might be
helpful. Your greatest friend when it comes to terminating
an undesired program or process is Task Manager.




9. Game Bar (Windows
Key-G)

To open the Xbox Game Bar, use the Windows Key-G
keyboard shortcut. For things Ilike audio settings,
performance, friend activity, and screen recording, it has
several choices and displays. You, who are not a player,
could still find it helpful. For further information on gaming
with Windows 11, see Jordan Minor's piece, With Windows
11, Microsoft Turns Every PC Into an Xbox.

10. Windows Key-L (Lock
Screen)

To get back to the lock screen, all you have to do is hit
Windows Key-L. If you don't want to completely shut down
your computer but still don't want anybody to view or use it,
this is useful in a public or business situation.

11. Windows Key-I:
Configuration

To open the Windows Settings program, use the Windows
Key-l. Using the keyboard shortcut may help since this is
less noticeable in Windows 11 than it was in Windows 10. It
was known as the | for information, if you remember.



12. Start Menu (Separate
Windows Key)

Although | have to confess that | don't frequently use this
really helpful keyboard shortcut, | want to alter that. After
all, I can enter the Start menu with just a single keystroke,
and how often do | use it anyway? (Frequently.) Windows
Key-S (or Windows Key-Q), which opens the Search panel
and allows you to search the internet and your computer, is
a close cousin of this key.

13. File Explorer (Windows
Key-E)

Another key command | want to use more often is Windows
Key-E, which opens the File Explorer. | use that program a
lot.



14. VVidget;; (Windows
Key-W)

The Widgets panel may be accessed using the new Windows
Key-W keyboard shortcut for Windows 11. Once it is opened,
you may navigate between its sections by navigating
between items within each area using the Tab and Arrow
keys. An outline surrounds the chosen item, as shown in the
Weather widget above.

15. Windows Key-A: Quick Access



This shortcut opens the new Quick Settings panel (the A
stands for Action Centre, because Windows 10 replaces
numerous Action Centre features). You may adjust the Wi-Fi,
Bluetooth, Airplane mode, Focus Assist, Battery Saver, and
Accessibility settings when you visit the panel. Additionally,
sliders may be utilized to adjust speaker volume and screen
brightness. The gear icon opens the full Windows 11
Settings program, while the pencil symbol allows you to
customize the options.

16. Notifications (Windows
Key-N)

Windows Key-N, like the previous shortcut, opens the
Notification panel. In Windows 10, the Notification panel was
housed in the Action Centre. As one would anticipate, the
bottom of the screen shows any alerts you've received in
addition to your schedule. Sadly, when Windows 10 was
updated to Windows 11, the calendar lost a lot of its
functionality. You are no longer able to view or add events to
your agenda.

17. Snap Layouts
(Windows Key-2Z)

Snap Layouts is enabled by this combo. It works similarly to
moving the mouse pointer over the maximize button of a
window, except it happens more quickly.



18. Windows Key-Alt-Up
Arrow: Half-Screen Resize

The current program gets resized to the top half of the
screen using this key combination. Similarly, by pressing
Windows Key-Alt-Down Arrow, Windows Key-Alt-Left Arrow,
and Windows Key-Alt-Right Arrow, you may have the
application occupy precisely half of the screen in those
directions.

19. Cast Media (Windows
Key-K)

Using Windows Key-K, you can cast (Kast?) your screen onto
a wireless monitor. The Quick Settings panel has the option
to have a button added, however using this shortcut will
save you time.



20. Windows Key-C: Team
Chat

The new Windows 11 keyboard shortcut C is for discussion,
which opens the Microsoft Teams chat personal edition. This
personal version is used by very few Windows enthusiasts,
so Microsoft, good luck. Its ability to SMS chat with phone
users without requiring the creation of an account is one of
its main advantages.



SHUTTING DOWN AND
RESTARTING
A WINDOWS 11 PC

Q Sleep
Q) Shut do.,

O Restart

Often, problems that
sometimes occur with Windows 11 and the programs that
run on it may be resolved with a fast PC restart. In addition
to troubleshooting, there may be many times when you'll
need to restart your computer after shutting it down,
including after a Windows update.

Rebooting a Windows 11 computer may be done in a few
different ways. Having emergency supplies on hand is
usually a smart idea, even if you won't use them all.

1. Restart Windows 11 from the Start Menu.

Restarting a Windows 11 computer is as easy as selecting
Restart from the Start menu after selecting the Power sign
located in the top right corner of the screen.

Let's say you install a Microsoft update and then restart your
PC. If so, you'll get a time estimate along with an extra
Update and restart option. Choose it if you want to complete
the upgrade.



2. Reboot Windows 11

using the Power User
Menu.

Another simple method for restarting your computer is via
the Power User Menu. Press Windows + X, right-click the
Start button on the taskbar, choose Shut down or sign out,
and then select Restart.



Shut Down Windows

o= Windows 11

[: What do you want the computer to do?

: [ Restart

Closes all apps, tumns off the PC, and then turns it on again
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3. Use the Keyboard Shortcut to Restart Windows 11

Moreover, a keyboard shortcut may be used to restart your
computer. Simply go to your desktop and press Alt + F4 (or
Fn + Alt + F4 if your keyboard includes a Function key).
When the "Shut Down Windows" dialog box appears, select
the Restart power option from the drop-down menu and
click OK.

4. Restart Windows 11 by pressing Ctri-Alt-Del.

Alternatively, you may utilize the Ctrl + Alt + Del screen
(sometimes called the Windows Security screen) to restart




your computer with Windows 11. Press Ctrl + Alt + Delete,
then choose Restart by clicking the Power icon in the lower
right corner of the screen.

The Ctrl + Alt + Del screen is present even if your system
freezes, which makes it a perfect option to restart a frozen
PC. You can even enter the Task Manager directly, so before
you restart the computer, you may want to terminate any
stopped jobs.

5. Reboot Windows 11
from the Lock/Login
Screen

Restarting your computer does not need you to be in into
your user account. In the event that you need to restart
Windows 11 when at the Login or Lock Screen, click the
Power icon in the bottom right corner and choose Restart.




6. Restart Windows 11
from the command line.

Restarting your Windows 11 PC using the Command Prompt
or Windows PowerShell interface is an option for terminal
nerds.

Start by opening Windows PowerShell (choose Windows
Terminal on the Power User Menu) or Command Prompt
(enter cmd.exe into the Start menu). After entering
shutdown /r, press Enter. Your computer will reboot in sixty
seconds.

Use the following switches to immediately restart your
machine:

shutdown /r O

To set the time in seconds that the operating system takes
to restart itself, change the number in the command above.
For example, you may set the time to 3600 to postpone the
restart by one hour.

7. Restart Windows 11
using the Run Box

The commands mentioned above may also be used with




Type the name of a program, folder, document, or
=) Internet resource, and Windows will open it for you.

Open: | shutdown /r /t 300|

Cancel Browse...

run. Press Windows Key + R to bring up a Run box. Type
shutdown /r to restart Windows 11 in 60 seconds, or
shutdown /r /t time in seconds to reboot Windows 11
immediately or gradually, and click Enter.



8. Windows 11 Hard
Reboot

A hard reboot is necessary if the aforementioned fixes don't
work and your computer is frozen. We don't suggest it
unless absolutely essential since it may result in file damage
and data loss. To darken the screen, just hold down the
Power button (some laptops may need you to hold down
another button). Next, hit the Power button one more to
restart your computer.



Use the Restart button on the CPU casing of your desktop
PC if there is one to force a hard reboot.



9. Plan a Windows 11 restart

You may plan a restart using Windows' built-in Task
Scheduler. Additionally, you may decide whether you want
this to be a one-time or ongoing duty. To make this happen:

Open Task Scheduler by searching for it in the Start menu.

Actions
Task Scheduler (Local)

Connect to Another Computer..

J

Create Basic Task...

L Create Task..
Import Task...
5 Display All Running Tasks
is| Disable All Tasks History

AT Service Account Configuration

On the right pane, click Create Basic Task.



Click Next after giving the task a name (such as Restart).



Select Daily, Weekly, Monthly, or Once, and then click Next.

Select Next after specifying the time for the restart.




Choose the radio button next to "Start a program" after
that.

Input the path as follows in the Program/script field.
C:\Windows\System32\shutdown.exe



Enter -r (optional) in the area next to Add arguments.

Choose Finish.

You have sixty seconds to complete the assignment before
your computer reboots. Step 8 requires the addition of the -t
time-in-seconds option if you want to modify the delay
length.

10. Restart Windows 11 by



using the Desktop
Shortcut

If you would want an extremely fast method to restart
Windows, you can always create a desktop shortcut! Right-
click on a blank area on your desktop and choose New >
Shortcut to do this.



In the command line, type shutdown /r /t 0 (you may
optionally specify a time delay).

To save the shortcut, give it a name, like Restart, and click
Finish.



What Is the Difference
Between Shutdown and
Restart?

It's crucial to understand the difference between manually
shutting down your computer and then turning it back on
while requesting an automatic reboot before moving
forward. Despite the fact that both approaches seem to
provide the same outcome, this isn't the case because of a
feature called Fast Startup.

Fast Startup caches several sorts of system data when you
choose Shutdown, which is an option in many of the
aforementioned strategies. This helps your computer boot
up more quickly from a cold start. But when dealing with
persistent operating system errors, this might cause issues.

Restart is the better choice if you want to solve issues since
it doesn't activate if you choose it. If you don't plan to use
your computer very soon, this is also the most convenient
solution.

But if you'd want, you may turn off Fast Startup. Go to
Hardware and Sound > Power in the Windows Control Panel,
open it, and uncheck the box next to Turn on quick startup
(recommended).



HOW TO UNINSTALL PROGRAMS
IN WINDOWS 11

Removing unnecessary applications from your Windows 11
PC is a great way to keep things organized and save up
important disk space.



Tiorme P n— -
vipe here 10 search

Pinned All spps

C d A ¢ i H

Edge Word Bxcel PowerPoint L F alandne
T Movetotop
i - @ u R Unpin from Start
Microsoft Store Photos Settings OneNote B Run as administrator
“il - g o Open file location
— Hi - ﬁ 9 Pin to taskbar
Notepad Paint File Explorer Mowvies & TV
@ Uninstall
Raecommanded More
Marshall Gunnedl CV Zhao Yu - Independent Contracior
o B e
m' y Zhso Yu - Independent Contractor " Reyadh Rahaman - Independent C
sl Th ago u i h ago
n Rhett Roxl - Independent Contract. mT ‘ Rhett Roxl - Independent Contract
7h ago ~| Thago

. Gunnell ()
Mo EBOC+ @O0V 2920

Uninstall apps from the
Start Menu



In Windows 11, you may quickly remove an application from
the Start menu. Click the Windows symbol on the taskbar to
open the Start menu. At the top of the Start menu is a list of
pinned applications. If the program that you want to
uninstall is listed here, right-click it and choose Uninstall
from the context menu that pops up.

To the right of the pinned apps group, choose All Apps if the
app you want to unpin isn't visible among the pinned apps.
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The full list of applications will appear on the screen that
follows. Find the program that has to be uninstalled, give it a
right-click, and choose Uninstall from the context menu.

PowerPoint

\\\\\

.'__0
i

.............

When you do, a pop-up notice will appear. You will be
informed by the notice that the app will be removed along
with all of its related data. If you're positive, click Uninstall.
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Uninstall programs from
the Settings app

You may utilize the Settings app to remove applications if
you like it. To begin, click the Search button located beneath
the Windows taskbar, enter "Apps and Features" into the
search field, and then choose the Apps & Features item from
the list of results.
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You are now in the Settings app's Apps and Features area.
Find the application that you want to uninstall, click the
"menu" button that appears to the right of it, and choose
Uninstall from the menu.
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You will be notified via a pop-up dialog box that the software
and all related data will be removed. If you're positive, click
Uninstall.



Uninstall apps through the
Control Panel

Launch the application, then choose remove a program from
the Programs group to remove it via the Control Panel.

A list of applications will show up. Find the app that has to
be uninstalled, give it a right-click, and choose Uninstall.
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Using Windows Terminal,
uninstall programs

If you want to feel like a hacker, you can delete an app
using Windows Terminal. Start by right-clicking the Windows
icon on the taskbar, then choose Windows Terminal (Admin)
from the Power User menu to open Windows Terminal as an
administrator.

You now have to utilize Windows Terminal's WMIC (Windows
Management Instrumentation Command-line) program to
remove applications. Enter the following command to use
WMIC:

Wmic



Right now, you are in wmic:root\cli. Now, a list of the apps
installed on your Windows 11 computer ought to appear.
Don't miss this step since the program name that you need
to enter in the next steps to remove the app is precisely as
it appears in this list.



Execute this command to get a list of programs:
A product's name is assigned.
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Uninstall product where
name="program name"

Change "program name" to the name of the software itself.
For instance, | would run the following command to remove
ExpressVPN:

remove the product where "ExpressVPN" is listed.

When you execute the command, a confirmation screen will
appear asking whether you really want to uninstall the
program. Type Y to verify.



HOW TO FIX WINDOWS 11
WHEN
IT KEEPS RESTARTING

Should Windows 11 restart on its own, there can be a
serious issue. It's possible for your gaming session to end
abruptly, for your work progress to be reversed, or for online
meetings to be interrupted.

When this happens, you know your computer isn't working
properly. Numerous factors, such as overheated hardware,
malware infestation, or an out-of-date graphics driver, might
cause Windows to restart.

If you recognize this, keep reading and we'll walk you
through the troubleshooting process.

1. Check the temperatures
of your GPU and CPU.

If you use design software on your Windows 11 computer or
play intense graphics games often, it might be an indication
that your system is overheating. In order to safeguard the
hardware, Windows often has to restart the computer when
the CPU or GPU temperature becomes too high.

The hardware on your computer often overheats when you
use a lot of programs and consume a lot of its resources.
Inspect the temperature of the CPU and, if it seems
sufficiently cool, the GPU.

Let's say you notice that as soon as your computer turns on,
your hardware begins to overheat. If so, it's possible that
your cooling system is broken. You should take it to a
qualified supplier and get it fixed to prevent permanent
harm.



2. Do Not Overclock Your
Computer

You understand that you're straining the hardware of your
RAM, CPU, or GPU if you've decided to overclock your
machine. It will strain your computer and increase the
temperature of the hardware even if it could enhance
performance overall. This is particularly valid if your cooling
system hasn't been updated.

To return your computer to its original condition in the event
that it restarts at random, remove any overclocking
software. If you're not interested in switching out your
hardware, think about whether overclocking is really
worthwhile.

3. Examine the Power
Supply

Your computer may restart itself if its power supply is broken
and unable to provide a steady voltage. Your computer
could restart even with an uninterruptible power supply
(UPS) if the UPS or battery isn't working properly.

Let's say you put RGB lights and they seem to be flickering.
If so, it could be time to replace the power supply in your
computer since voltage fluctuations might have an impact
on lighting. Examine the power supply's wiring before
replacing it to make sure that a malfunctioning wire isn't the
cause of Windows 11's sudden restarts.

4. Confirm that Windows
updates are not to blame.



You may choose to schedule the update that Windows 11
asks you to perform. Your computer may thus restart in
order to install any upgrades.

You may either manually apply the pending updates or
disable Windows 11 updates to prevent automated restarts.

5. Scan Your System

You could have malware on your computer if it continually
crashing and freezing and restarts by itself. Thankfully,
Windows 11 comes with built-in programs that you may use
to scan your system. This is the method to follow:

Go to the option that says Settings.

Go to Windows Security > Virus and threat protection under
Privacy and Security.

Selections for the scan should be made.

Quick scan is ideal if you're pressed for time, but Full scan
will examine every file and running application on your
computer.

After Windows has finished scanning, it will inform you of
any malware that has been found and if the malicious file
has been quarantined or deleted.



6. Download and install
the most recent graphics
driver.

One of the many problems that might arise from using an
outdated graphics driver is your computer restarting itself.
Updating Device Manager to the most current version will fix
the problem.

To access the Start menu, press Win + X, and then choose
Device Manager. When you right-click on the appropriate
driver, you may choose Update driver after expanding the
list of Display adapters. Windows will search for and install
any updates if you choose the option to "Search
automatically for drivers" in the pop-up window.

If your computer has both an integrated and a separate
graphics processor, there may be more than one driver. To
keep your active GPU up to date, you may thus either
update the drivers for the CPU you're currently using or
update them all at once.

If it still doesn't work, download the graphics processor
drivers and contact the manufacturer of your GPU.



7. Run a CHKDSK scan.

Windows 11 may randomly restart due to a failed storage
sector that prevents your system from connecting with
subcomponents. A CHKDSK scan might be performed to see
if it helps.

Press Win + S and enter "Command Prompt" without hitting

Enter to do this. Run as Administrator should be selected
when you right-click the search result instead.

Enter chkdsk /r [DriveLetter:] into the command prompt
window when it has opened, changing [DriveLetter:] to the
drive letter you want to scan. Your failing drive may need to
be replaced if the command is unable to fix the issue.

8. Check for Memory
Problems

Your computer may restart itself if your RAM dies. To find
any problems, you may utilize the Windows Memory
Diagnostic tool.

Use the Windows Memory Diagnostic program, choose
Restart immediately, and check for errors (recommended)
to do this. After that, Windows will check your RAM to see if
there are any issues.

9. Turn off Automatic
Restart.

If you are unable to identify a computer issue, you may
want to consider disabling Windows 11's automatic restart
option.

The setup starts.



Select System > About.

Select the Advanced system settings option from the
Related links menu.

Click the Advanced tab and then Settings under Startup and
recovery in the System Properties box.

Disable Should a system failure occur, restart automatically.

To preserve your recently modified system settings, click
OK.

Since you've now stopped your computer from restarting in
the case of a system failure, which might result in more
serious issues, this is not a long-term solution.

10. Restore a Previous
Version of Windows

Let's say you believe that Windows 11 is restarting without
warning because of a recent system change. If so, you may
fix the problem by returning your computer to its previous
state. If you have a system restore point created, you ought
to be able to use it.

Disabling Windows 11's automated restart feature.



As stated before, Windows 11 may restart itself for a variety
of reasons. Sometimes hardware problems arise even when
there is nothing wrong with your machine. Even though it
could be difficult to pinpoint the issue, with a little
perseverance and the above-mentioned methods, you
should be able to resolve it.



ACTIONS TO TAKE AFTER
INSTALLING WINDOWS 11

The most current version of Microsoft's operating system is
called Windows 11. In comparison to previous iterations,
these regions now have a new start menu, notification
center, system tray, redesigned taskbar with rounded
edges, and other enhancements.

This implies that in order to get the most of your computer,
you'll have a lot to study and understand after installing it.

For this reason, we've put up a list of the top 10 things you
should do as soon as you install Windows 11. All the
information you need to maximize your system's capabilities
and have a more enjoyable gaming and working experience
is included in the list.

Now that Windows 11 has been installed, let's get started
and see what has to be done!

One of the greatest Windows operating systems ever
released by Microsoft is Windows 11. With a...

Learn more.

1. Update drivers

After installing any operating system, you should make sure
your computer's hardware drivers are up to date first. It's
conceivable that some of your device drivers won't function
with Windows 11 since it's a new update.

For instance, it's possible that Windows 11 is incompatible
with your printer driver. Therefore, if drivers are available,
it's a good idea to look for and install Windows 11
compatible drivers.

With Windows Update, you may quickly install the drivers
that are available and necessary.



Windows Update

Checking for updates.

K~/

This is how you do it:

To reach the Settings menu, press Windows + |[. After
selecting "Windows Update" from the Settings sidebar,
choose "Advanced Options."

It will display the Advanced Options window. Make the
choice "Optional Updates".

Expand the "Driver Updates" section's header under
"Optional Updates." Next, choose the drivers you want to
update by scrolling down the list and checking the box next
to each one. After finished, choose "Download & Install.”



2. Remove all superfluous
programs

Insiders claim that Microsoft has signed many agreements
with other vendors to display product stubs on the upgraded
Windows 11 Start Menu. Included are icons from Picsart Pro,
WhatsApp Line, and Adobe Lightroom.

Clicking one of these buttons will start the download and
installation of the application.

While some of these programs may be worth trying, most of
these icons only serve to further complicate things on your
Start Menu. To get rid of these things, right-click the icon
and choose Uninstall from the menu that shows up.

3. Add (misplaced) useful
apps

Although they don't by default, there are several programs

that could be wanted to appear on the Start Menu.

Now is the moment to find them if any of them are missing.
Similar to Windows 10, Windows 11 allows you to pin



programs to the Start menu. But instead of live tiles, the
Start menu now has simple icons with explanations.

Users of Windows 11 could still find it difficult to locate an
app list on the new system, in which case our guide might
be useful.

After selecting the Start button, look for the All applications
option in the upper-right corner.

In Windows 11, find the program you want to pin to the
Start menu, then right-click on it.

Click Pin to get started.

Programs and folders may also be pinned from the Desktop
to the Start menu.

To pin an application or folder, right-click on it and choose
Pin to Start from the context menu.

4. Remove any clutter
from the Taskbar Menu.

To create room for more significant icons and programs, you
may delete unneeded ones from the taskbar. In order to do



this, right-click on a vacant area of the taskbar and choose
Taskbar settings from the menu that appears.

Turn off all of the taskbar's unnecessary features now.

This will free up space in the taskbar menu so that the list of
your most frequently used apps may appear. Your system
will also be optimized to provide a better user experience.

You may see that the taskbar now lists a few extra apps
after downloading Windows 11. You may remove all of the
unnecessary stuff, such program icons and suggested
applications, if you so want.

Go to "Settings > Personalization > Taskbar" to change your
taskbar.



5. Customize Windows 11

Making Windows 11 more suited to your needs is what
comes next: personalization. You may customize the look of
your laptop or computer by changing the transparency,
adding a background picture, or changing the desktop
theme.

Select Personalize from the menu that appears when you
right-click on the desktop.

With  Windows 11, themes, backgrounds, music,
screensavers, mouse pointers, and other elements are now
customizable. To do this, choose any of the Personalization
options and make the necessary changes.

Personalization

Simply navigate to Settings > Personalization. Many
elements, such as themes, backgrounds, lock screens,
colors, fonts, and more, can be customized from here.



6. Examine the Privacy
Settings

After installing Windows 11, you should verify your privacy
settings one more time. Within the Settings menu, choose
Privacy. This is where you may control the data that
Windows 11 and other apps store.

Since there are so many advantages to this information, you
should take the time to go over what is being said. Any
settings that you do not wish to share or that do not relate
to you should be disabled.

7. Examine the Power
Settings
Optimise the power settings on your laptop or computer and

set up Windows 11 to enhance performance. Options like
Sleep Mode, Battery Saver, and others could be accessible.

By default, the power mode is in the balanced position. Go
to Settings > System > Power & battery to change the
power mode on your computer if you want to maximize its
performance. Verify that "Best performance" is selected in
the power mode.



8. Backup your computer.

After installing Windows 11, the most important thing you
should do is make a backup of your personal stuff. This is
the perfect opportunity to put in place a system backup plan
if you don't already have one.

Making a backup of your computer is essential before
making a mistake. The system restore function in Windows
11 may help you restore the system in case of a problem.
Create a system image for recovery rather than restarting
the machine.

0. Ensure that vyour
antivirus software IS
enabled and working.

After installing Windows 11, you should immediately turn on
your antivirus software. Even while Windows 10 comes with
Microsoft Security Essentials for free, some users prefer
third-party apps. As you want to make sure that your
computer is protected from viruses and other security
concerns, this is a crucial step.

Most viruses are transmitted via rogue websites or email
attachments. Using antivirus software is another fantastic
way to prevent such files from being on your laptop or
computer.



10. Check for updates.

As Microsoft updates its products often, be sure that
Windows 11 is the most recent version. To do this, choose
"Settings > Windows Update." Select "Check for updates."

When new versions of operating systems or security
updates are released, users should always update their
computers. It's the best way to maximize Windows 11
performance and safeguard against malware and other
security risks.

11. Install OneDrive

A complimentary 5GB of cloud storage in Microsoft OneDrive
is yours when you register with a Microsoft account. It may
be a bit tricky to configure if you've never used it before,
but don't worry. You'll get used to it rather fast.

Windows will launch the application and display a window
that looks just like the File Explorer window you normally
see, complete with your Desktop, Documents, Downloads,
and Pictures folders. The OneDrive service includes these
folders, so whatever you save in them will be backed up to



your OneDrive account. This is where things get a little
trickier. Turn this off if you have backup storage.

Open OneDrive from your notification area, choose Help &
Settings > Settings > Backup> Manage OneDrive backup,
and then click OK to change the settings. This will direct you
to OneDrive's backup settings page.

12. Sandbox on Windows
11

For individuals who have Windows 11 Pro, Enterprise, or
Education, this is an essential feature. Without requiring any
difficult setup, it enables you to quickly and simply create a
secure virtual computer. Because the virtual machine (VM)
is totally separate from your primary system, you may
safely browse a dubious website or test out new software.
The sandbox will completely disappear when you close it,
leaving no record of your experiment.

Despite using the same virtualization technology as Hyper-
V, it uses a very little amount of system resources and
doesn't need activation.

First of all. Go to Search and put Windows Features into the
search box to locate the "Turn Windows Features On-Or-Off"
dialogue box. To activate the "Windows Sandbox" feature,
tick the box at the bottom of the list. A Windows Sandbox
shortcut will show up in the Start menu upon a restart.

It is important to note that almost no Microsoft programs are
present in a Windows Sandbox session. It's completely rill-
free. You may copy a software file to the sandbox for further
examination or paste a URL into Microsoft Edge by using the
Windows Clipboard.



13. Organize Your Storage

In the event of an update, there can be a large number of
undesired temporary files, including files from earlier
installations. These files are just there on your disk and have
no use. We advise routinely clearing out the storage space.

Organizing storage:

Hit "Windows+I|" to open "Settings." Go to "System" >
"Storage" by navigating.

Choose "Cleanup Recommendations" by clicking on it.

14 Configure the Sign-In Methods

Windows 11 offers a multitude of sign-in options. You are
free to adjust the sign-in settings however you see fit.

In order to open "Settings," use "Windows+I". Click "Sign-in
choices" after selecting "Accounts".

To set the sign-in option, choose the one that best suits your
requirements and follow the instructions.



15. Pin Apps That Are
Useful

Some apps are hidden by default on the Start Menu, but you
may wish to display them. It's time to find everyone who
may be missing. After installing Windows 11, adding apps to
the Start menu is the next step. With Windows 11, you may
achieve the same goals as with Windows 10. Instead of
"live" tiles, the Start menu now displays simple symbols
with explanations.

This lesson might help if users of Windows 11 are still
unable to locate a list of all accessible programs.

Look for the All applications button in the top-right area
after selecting the Start button.

To pin an app to the Start menu in Windows 11, right-click
on it and choose "Pin to Start Menu."

Select Pin to get started.

From the Desktop, you may pin folders and programs to the
Start menu.

Right-click the program or folder you want to pin, then
choose Pin to Start from the context menu.




As you can see, after installing Windows 11, there are a lot
of activities to do. These are just a few of ways in which
consumers might begin their journey. Following the
installation of Windows 11, some users may choose to
register a Microsoft account or utilize Cortana. It all depends
on your own preferences and your plans for using Windows
11.

These tips ought to help you get up and running with
Windows 11. If you follow these guidelines, your PC can be
optimized to function the way you want it to. Several of
these tasks may have a big influence on how Windows 11
works for you and how you use it.



HOW DO | MOVE THE WINDOWS
11 START MENU

One of the most important additions to Windows 11's user
interface is the Start Menu. The Windows 7 classic shortcuts
have reappeared, while the Windows 10 tiles have
disappeared. Furthermore, the Windows 11 Start Menu now
sits in the middle of the desktop and has additional
components. If you would want to see the Start Menu and
taskbar again on the left side of the screen, follow these
instructions to adjust their alignment:

The Start Menu and taskbar in Windows 11 are, by
default centered.

Windows 11 follows the Mac's lead when it comes to how
the taskbar and Start Menu are displayed. As can be seen
below, the taskbar icons are centered, and the Start Menu
appears in the middle of the desktop when you click the
Windows logo.

The Start Menu and taskbar icons were positioned on the
left side of the screen in previous versions of Windows 7 and
10. In Windows 11, you may also have them shown to the
left, as seen in the picture below.



How to Put tl;e Start Menu
on the Left Side of the
Screen

If you want the Start Menu and your taskbar icons to be on
the left side of the screen, you have to first visit the taskbar
settings. To do this, choose Taskbar settings by performing a
right-click (or press and hold) on the empty area of the
taskbar.
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Alternatively, you may use your keyboard's Windows + |
keys to enter Settings. Then, choose Personalization from
the column on the left. Click or press this area after swiping
down to the Taskbar on the right.
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In the Taskbar Personalization settings, go down to Taskbar
Behaviors, and click or press on it to make it larger.

Taskbar behaviors
Taskbar afignment, badging, automatically hide, and multiple |
Left
Taskbar alignment | Center

Automatically hide the taskbar

Show badges (unread messages counter) on taskbar apps

Instead of choosing Center from the Taskbar alignment drop-
down menu, choose Left.

Right away, the taskbar and the Start Menu are positioned
in the left corner of the screen. This closes the Settings



window for you. To go back to the standard centered
method, repeat the preceding steps and choose Center from
the Taskbar alignment drop-down option.

Methods for Customizing
and Improving the Start
Menu

Windows 11's Start Menu differs from Windows 10's in terms
of appearance and functionality. The controversial tiles have
disappeared, and we are happy to see the simple Windows 7
shortcuts return. The changes don't end there; in addition to
program shortcuts, the Windows 11 Start Menu also shows
recently opened files, frequently used applications, and
recently installed apps. Additionally, it has a redesigned
layout, something that the original Windows 11 was not able
to do. If you want to add folders to the Windows 11 Start
Menu, modify its Ilayout, remove files from the
Recommended section, or alter its look, read here.

The appearance of the Start Menu in Windows 11

The Start Menu opens when you click or press the Windows
logo, sometimes referred to as the Start button, on the
Windows 11 taskbar. Pressing the Windows key on your
keyboard has a similar effect.

By default, the Windows 11 Start Menu is partitioned into
the following sections:

You may search for programs, documents, settings, and
other items on your computer by typing terms into the
search box at the top.

Here are some tips for using Windows 11's Search feature.



Microsoft applications are shown in the Pinned area under
the search box; you may pin more things if you'd like.
Clicking or touching an app's name or icon opens it. There
may only be eighteen pinned items shown on the list. It's
possible that the list is longer than that. You may navigate
through it by clicking or tapping the dots to the right of the
Pinned section.

Press the All applications icon located in the top-right corner
of the Pinned section to get a list of every program that is
compatible with Windows 11.

Then comes the Recommended section, which has your
most-used applications, newly added apps, and regularly
accessed items. You may see a More button to the right of
this section, which opens a longer list of items in the same
category.

Your picture and login are on the left, while the Power button
is on the right.




In Windows 11, where do
you personalize the Start
Menu?

Most of the areas in the Start Menu may be customized. In
Windows 11, type Settings to see all of the setup options.
Using the keyboard shortcut Windows + | is one way.
Navigating to Start and then Settings is an additional option.

Select Personalization from the Windows 11 Settings menu
on the left. Click or press Start on the right after swiping
down to find it.



The Windows 11 Start Menu customization choices are
shown. You should be able to customize your Windows

11/2022 Update or later system to appear somewhat like
the screenshot below.



There are few choices available while using Windows 11's
initial edition, as this screenshot illustrates:

Let’s go over all customization choices one by one

1. Changing the Start

Menu Layout Iin Windows
11

The section on layout featuring the three alternatives If you
are using Windows 11 2022 Update (version 22H2) or later,
More pins, Default, and More suggestions appear first.



Personalization > Start

Layout

More pins o Default More recommendations

As shown in previous pictures, the Default configuration has
the Pinned and Recommended sections occupying about
half of the Start Menu. This is how your Start Menu will
appear if you choose More pins:




For me, this layout is better than the default as it lets me
create more shortcuts for other programs. The Start Menu's
layout changes if you choose "More recommendations,” as
shown below:

The Recommended area occupies a much larger space than
the Pinned portion, as you can see. | think fewer individuals
will find value in this arrangement. It will probably only be
used in business environments by staff members who often
handle a lot of paperwork.

2. How to show or conceal
items In the Start Menu's
Recommended section

Windows 11 shows your recently opened files and apps in
the Recommended area of the Start Menu by default. It may
also show you the applications that you use the most often.



In order to eliminate these items from the Start Menu,
deactivate the following switches:

Shortcuts to newly installed programs from the Start Menu
may be useful to certain users. Among these options is
"Show recently added apps".

Windows 11 looks at the programs you use most often and
displays a list of them in the Start Menu when you enable
the "Show most used apps" option.

The option "Show recently opened items in Start, Jump Lists,
and File Explorer" affects all Windows 11 programs that
show recently opened items, including File Explorer and the
Start Menu.

Toggle (turn it on and off) by simply clicking or tapping on a
switch.

L\lz_, Show recently added apps On m
f{ Show most used apps off @
5 Show recently opened items in Start, Jump Lists, and File Explorer On m

Turn off all three switches to clear the Recommended
section.

3. Determine which folders will appear on the
Windows 11 Start Menu.

By default, the Power button appears in the lower-right area
of the Windows 11 Start Menu. Nevertheless, you may make
a number of folders close to it that serve as fast connections
to frequently visited locations. To add or delete folders from
the Start Menu, click or tap Folders in the list of
customization options.

You can see a number of folders on Start, next to the Power
button (this is your user account folder), including the



rsonalization > Start

Settings, Documents, File Explorer, Downloads, Music,
Videos, Pictures, Network, and Personal folders. To add the
folder to the Start Menu, turn its switch to On. To take it out
of the Start, flip its switch to Off.

Add all of the available folders, and the Start Menu becomes
congested very rapidly with no way to tell them apart.
Therefore, it is preferable to activate only the directories
that you often explore. | selected Documents, Downloads,
Pictures, and Settings, for instance. See how the Start Menu
looks with more pins and a few shortcuts placed at the
bottom by looking at the screenshots below. Isn't it a lot
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4. How to Add Folders to
the Start Menu in
Windows 11

Windows 11 2022 Update (version 22H2) allows you to
create folders on the Start Menu as well. To achieve this,
click and hold a shortcut from the Pinned section, or touch
and hold one.
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After that, drag it over a different shortcut to add to the
folder. Notice the way that a folder named Folder has been
created. Continue to drag and drop shortcuts into the same
folder after that.

Once you're done, tap or click the folder to access the Edit
name area, where you may change the folder's name. To
activate it, just click or press outside the folder.

Use these instructions to create and name a folder on the
Start Menu.



CHANGING THE BACKGROUND
ON WINDOWS 11

B X 0O a W
Bl Open Enter
s Open with H
E] Set as desktop background .
<1 Rotate right _
= Rotate left
7 Compress to ZIP file I
[ Copy as path
j Properties Alt+Enter I

© Share with Skype

E7 Show more options Shift+F10

Would you want to know
how to alter the wallpaper in Windows 117 The elegant and
beautiful Windows 11 default wallpaper is provided by
Microsoft. In Windows 11, it's the wallpaper image that
really distinguishes your computer or device. The Windows
11 desktop wallpaper is something you'll see a lot, so
choose something you like. By following the instructions
given in the subsequent paragraphs, you may use any
image or slideshow as your Windows 11 desktop
background:

1. Change the background
of vyour Windows 11



desktop by using the
right-click menu.

In Windows 11, using the contextual or right-click menu is
the fastest method to modify the wallpaper. On your
computer or smartphone, start by right-clicking or by
pressing and holding the picture you wish to use. Next,
choose "Set as desktop wallpaper" from the contextual
menu by clicking or pressing on it.

Photos stored on your desktop or in a folder that you can
open with File Explorer may be processed using this
approach. But File Explorer offers additional options when it
comes to altering the background in Windows 11.

2. Using File Explorer, update the desktop wallpaper
in Windows 11.

Using File Explorer to find the picture you wish to use as the
Windows 11 background is another fast way to get there.
Click or press the picture to choose it, and then use the
toolbar at the top to click the "Set as background" button.



These two methods work well for quickly switching Windows
11's wallpaper. Nevertheless, the Settings app offers more
sophisticated options, as you can see in the paragraph that
follows.



3. Changing the wallpaper
in Windows 11 by
installing a new theme

Your operating system's theme modifies both the audio and
visual elements. A few of Windows 11 themes come with an
amazing assortment of wallpapers. To change the desktop
wallpaper theme, open the Settings app and choose
Personalization. "Select a theme to apply" at the top
displays a few of the possible themes. You may click or
press any of them to give them a try.

For further options, go to Personalization and scroll down to
the Themes section.



Personalization > Themes
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Choose your favorite theme from the list of available ones
under Current theme. This includes both the themes you
create and those included with Windows 11. To get more
themes from the Microsoft Store, click or touch Browse
themes.

As vyou'll see in the next chapters, you may further
personalize any theme you choose from the Background
section.
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4. How to

Change the

Background of Windows
11 Using the Settings App

Alternatively, you may use the contextual menu to click or
touch on Personalize after right-clicking or pressing and
holding on a blank section of your desktop to access the

Personalization options.

Proceed to the Background settings after that.



On Windows 11, you may choose a favorite picture to use as
your wallpaper by checking the box next to "Personalize
your background."

A collection of the photographs you've recently set as your
wallpaper may be seen in the Recent photographs section.
Click or press the one you want to set as the background of
your desktop. If you would want to use a picture other than
those on this list, click or touch on the Browse photos
option.




Next, find the desired picture on your computer, choose it,
and then click or touch the Choose photo option.

Q Personalization > Background
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Windows 11 instantly loads the new picture as your desktop
backdrop. Hold on, though—there's more! You may choose
how the picture fits on your screen in the "Select a fit for
your desktop image" section below. Six options are
available:

Fill makes sure your picture has the proper aspect ratio and
fills the full desktop. One way to do this would be to crop
photographs.

Fit: This technique resizes your picture to fill the available
space without cropping and preserves the correct aspect
ratio.

retains the aspect ratio but stretches or compresses your
picture to suit the size of your screen. This may warp the
perception and give it an ugly appearance.

Tile - fills the available area on the screen by displaying your
picture many times.



Personalization > Background

Choose a fit for your desktop image fit
Choose your background color

Center: Places your image in the center of the display.
However, this may just display a single little image in the
midst of a sizable blank space, or it might only display the
central portion of a larger image.

Use Span to share the image across your desktops if you
have several displays.

If your photo does not fit the screen, you may "Choose your
backdrop color" at the bottom, as shown below. Take use of
the color contrast in your image to fill the rest of the screen.
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5. How to make a
slideshow the background



of Windows 11

A collection of photos that shift after a certain amount of
time is a feature of several themes. You may also use your
finest pictures to create a slideshow. Open the Settings app
and go to Personalization, then Background. Inside the
"Personalize your backdrop" box, choose Slideshow using
the dropdown menu.

By default, Windows 11 will utilize slideshow images from
the Pictures folder. To modify it, click the Browse option next
to "Select an image album for a slideshow.”

Locate the folder that has the pictures you want to have on
your desktop. Once it's located, choose it by touching or



selecting "Choose this folder." For instance, | choose the
Xmas folder, which has the wallpapers for Christmas.



Windows 11 launches a slideshow of pictures from the
designated folder and changes the desktop wallpaper all at
once. Since you may only use one folder, we advise you to
create one with the photos you want in it. You may then edit
your slideshow at the bottom. As mentioned in the last
chapter, you may adjust the number of times the picture
changes, rearrange the sequence, turn off the slideshow
when the battery runs low, and choose how the photos fill
your screen.

6. Changing the backdrop of the Photos app in
Windows 11



When Dbrowsing through your photographs in the
photographs app, it's easy to choose one of them as your
Windows 11 desktop wallpaper. You may either right-click or
touch and hold the picture to bring up a contextual menu.
Proceed to Set as and choose "Set as background."

A different option is to touch or click the See more (...) icon

at the top, choose Set as, and then choose "Set as
background."



CHECKING THE WINDOWS 11
VERSION AND EDITION

Microsoft released the first major operating system (OS)
update for Windows 11 one year after its release: the
Windows 11 2022 Update, sometimes referred to as version
22H2. several people are not sure whether they have
installed the latest version, and this is only the first of
several big updates. You may find out which version of
Windows 11 OS you are running with the help of this article.
It also shows you where to get the build number and edition
of Windows 11:

How to Quickly Check the
Windows 11 Version
Number and OS Build
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The easiest method to find out what version of Windows 11
you have is to use the winver application. Select the search



result with the same name by clicking or pressing the
Search button next to the Start button, typing winver.

As an alternative, you might use the Windows + R keys to
bring up the Run window, type winver into the Open text
field, and hit Enter.

Type the name of a program, folder, document, or

Internet resource, and Windows will open it for you.

Alternatively, you may use the Windows + R keys to launch
the Run window, type winver in the launch text field, and

then hit Enter or OK.



How to Determine Your
Windows 11 Version Using
the Settings App

An other way to get the same data is using the Settings app.
Start by going to Settings, which you can easily reach by
simultaneously hitting Windows and | on your keyboard.
With the System option chosen on the left sidebar, click or
tap About after swiping down the right side of the display.

This opens the About page on your computer. It offers
details on the operating system and machine you are using.
The following details are what we're searching for:



According to Device specifications, Windows 11 is a 64-bit
operating system, as shown by the system type.

Version: This indicates the version of Windows 11 you are
using and is shown in the Windows specifications section.
Home, Professional, Learning, Business, and so on.

System > About
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In the Windows specifications area, you can see the version
of Windows 11 you are now running.

OS Build: This column shows the actual Windows 11 build
that you are using and is also a part of the Windows
specifications list.

How to Determine the Operating System Version in
Windows 11 Using System Information

Another program that might assist you in figuring out what
build and version of Windows 11 you have is System
Information. Click or press the Search button to open this
app. Next, input system information into the search field.
Finally, click or tap the app's corresponding search result.

The OS Name and Version sections are clearly visible as
soon as System Information opens, letting you know the
version and build number of Windows 11 you are now



running in addition to its edition.

Ways to Utilize the Windows Terminal, PowerShell,
and Command Prompt Commands to Find the
Windows 11 Version
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Launch
your chosen app if you'd rather work in a command-line
environment:

Type this command, copy it, and put it in any of them:
BuildNumber, Caption, and Version are received by wmic
OS.

Then press the Enter key to launch it and see the necessary
data.

Take note that the information you requested is shown in
separate columns for BuildNumber, Caption, and Version:
Build number and version of Windows 11.
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This command may also be used to get the same data:
findstr /B /C:"OS Name" systeminfo "OS Version" /C

This command returns the OS Name (the Windows 11
edition) and OS Version (the Windows 11 version number
and the Build).

Use the following command to get the version number and
build rapidly:

| B Command Prompt X ST O

Microsoft Windows [Version 10.0.22621.382]
(c) Microsoft Corporation. ALl rights reserved.

C:\Users\cipri>ver

Microsoft Windows [Version 10.0.22621.382]

C:\Users\cipri>




As you have probably seen, the commands we have given
generate data that is not the same as what winver or
Settings show. The commands show the OS build and the
Windows 11 Version as a string of numbers. The same
applies to the System Information app. In the preceding
cases, the (build) numbers that follow 10.0 are 22621.
Continue reading to find out exactly which version of
Windows 11 you are running thanks to this build number.



What do the version
numbers in Windows 11
mean?

Microsoft plans to keep adding updates to Windows 11 and,
presumably, release a major version once a year. Every
update comes with a version number and comes with new
applications, features, internal enhancements, and more.
There are now only two versions of Windows 11 that the
general public may purchase:

The first release of Windows 11, known as build 22000 or
version 21H2, was released in October 2021. These are a
few of its strongest attributes.

The first significant upgrade to Windows 11 was build
22621, or version 22H2, and it was released in September
2022. What's new in Windows 11 2022 Update (version
22H2) is as follows.

The second major upgrade for Windows 11—version 23H2—
is anticipated in the latter half of 2023.

What are the distinctions
between Windows 11
editions?

On your computer or device, you may install one of the
following Windows 11 editions:

The Home Edition of Windows 11. One of the main Windows
11 editions for home customers is this one. It contains
consumer features and to use it, you need to have a



Microsoft account and an internet connection. It is devoid of
corporate features |like virtualization and BitLocker
encryption.

Windows 11 Pro. The second major release of Windows 11 is
this one. It has all of the functionality of the Home edition
plus additional features like BitLocker and the ability to join
a domain for power users and business settings.

Windows 11 Pro may be used on workstations. including
Windows 11 Pro, but with support for additional professional
features including faster file sharing, robust data storage,
and advanced processing.

Windows 11 SE edition. This version of Windows 11 is
designed for academic and educational institutions, as well
as low-end computers. It is the Windows 10 S substitute.

Education Edition of Windows 11. Similar to Windows 11 SE,
this version is intended for use in educational settings. It is
not exclusive to low-end smartphones, however, and it does
contain extra features.The Pro Education Edition of Windows
11. An upgraded version meant for educational settings. It
has several more useful tools in addition to most of the
features included in Windows 11 Pro.

Windows 11 Enterprise Edition. Along with all the features of
Windows 11 Pro, it also comes with extra tools for network
administrators and tech-savvy companies.

Mixed Reality on Windows 11. The Microsoft Hololens and
other mixed reality and virtual reality devices are meant to
be used with this version. It is not available on tablets, PCs,
laptops, or other comparable devices.

Microsoft may provide other Windows 11 versions, such as N
and KN, in addition to the ones already mentioned. There
are versions of Windows 11 without Media Player, Windows
Media Player, or any other multimedia functions. N versions
are available in Europe, whereas KN versions are available



in Korea. In these areas, where Microsoft has been found to
have misused its monopoly to undermine rival video and
audio programs, their only purpose is to adhere to antitrust
rules. N and KN may be applied to several Windows 11
versions. For instance, Windows 11 Home N, Windows 11
Pro N, and so forth are available to you.

What is the Windows 11
OS build number?

When significant Windows 11 improvements are
implemented, the OS Build number rises. As previously
indicated in this article's section "What do Windows 11
version numbers mean?", this information is helpful if you
need to know what version of Windows 11 you are running.
They may also be used to troubleshooting. Assume, for
instance, that you run across a problem and get in touch
with Microsoft's support staff. The OS Build then tells them
about your specific version of Windows 11 and the patches
needed to fix the issue. You may get more details on the
development of Windows 11 build numbers here: Windows
11 release information.

What is the system type of
Windows 117?

The system type simply signifies that Windows 11 utilizes
the 64-bit register of the CPU. We think this information is
unnecessary since Windows 11 only supports 64-bit CPUs.



ACCESSING YOUR DISK SPACE

Let's say you're curious as to what Windows 11 is using up
on your PC. If so, you might use the Storage options to
receive a prompt response.

The Storage function may also be used to assess the
contents of the drive, even if its usual purpose is to free up
hard disk space. By doing so, you may examine how the
available space is being utilized and determine what has to
be deleted in order to make room for anything that could
otherwise keep you from being able to use this function.
Windows 11 has "Cleanup Recommendations,” a tool that
may tell you which files and programs you can remove to
free up space on your computer's hard disk if it begins to fill
up. As an alternative, you may use third-party programs
(like WinDirStat) or DiskUsage, a command-line tool that
uses Command Prompt to evaluate a drive's storage usage,
to find out which files take up the most space and take the
necessary action.

This section will teach you how to examine your space use
using Windows 11's Storage settings. To find out what files
are using space on your Windows 11 hard drive, follow these
procedures.

On Windows 11, go to Settings.
Choose a System.
Navigate to the Storage page on the right.

Look at what's using space in Windows 11's “Local Disk (C:)"
region.

Check the box to see other categories.

Examine what other items—such as temporary files, apps,
documents, pictures, and more—are using space.
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(Details optional) In the "Storage management" section,
choose the Advanced storage settings option.
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Tick the box for Storage used on other drives.

Select the secondary drive.



Persona lization

New Volume (E:) - 39.9 GB -
-
A e Storage usage

View the drive's storage utilization.

You will be able to see which files are using up the most
space on your computer after you have completed the
steps.

The Storage choices provide you a detailed picture of
everything that is stored on any hard disk that is connected
to Windows 11. System files, applications, games,
temporary files, data from other users if you share the
computer, and files kept in Documents, OneDrive, Pictures,
Music, and Videos are a few examples.

Find out which files are using up space with WinDirStat.

With WinDirStat, you can monitor hard disk usage statistics
in more detail and discover exactly which files are using up
the most space.

You must use this third-party program at your own risk even
though it is nondestructive and often functions as intended.
You have been alerted.

WinDirStat should be installed on Windows 11.

To install WinDirStat on Windows 11, adhere to following
instructions.

Launch the software.
Look for Command Prompt, choose Run as administrator



Personalization

with a right-click on the top result, and press enter.

On Windows 11, execute the following command and hit
execute to install the WinDirStat program:

Install WinDirStat with winget.
WinDirStat

After the processes are complete, you can use the
application to scan the entire disk and receive a report
detailing the current amount of space being used on the
hard drive. Check which files are using up space in Windows
11.

To determine which Windows 11 files are taking up space,
use WinDirStat as detailed here.

Launch the software.

To open the app, search for WinDirStat and select the top
result.

Choose your individual drives carefully.
To see out what files are using up space, choose the disk.

Press the OK button.
Quick note: The program will stop and show the warning
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"Not responding" if there is not enough space on the device,
which  will make the experience extremely sluggish.
Eventually, however, it will finish correctly.

When the processes are finished, WinDirStat will scan the

disk and provide you a graphical report so you can see
which files are using up the most space.

It is possible to see which folder takes up the most space on
the top-left side of a tree file structure. To find the file using
the most hard drive space, you may expand and dive down.

Additionally, the file extensions that use the most space are
shown on the top-right side.



Each file is graphically represented as a rectangle at the
bottom of the page; the larger the rectangle, the larger the
file. The color of each rectangle indicates the kind of file
that is shown in the list of extensions.

If there's a certain file taking up a lot of space, you may
remove it via WinDirStat.

You can discover which files are using up space by using
DiskUsage.

DiskUsage is another software included in Windows 11 that
lets you use Command Prompt to examine drives.

Use these procedures to determine which files are using up
the most space in Windows 11's DiskUsage:

Open Start.

Look for Command Prompt, then choose Run as
administrator by right-clicking the first result.

In Windows 11, use the following command and hit Enter to
determine a folder's storage usage:

diskusage PATH/TO/LOCATION /h

Put
the location you want to examine in lieu of
PATH/TO/LOCATION in the command.

For instance, this command looks through the files in the
Downloads folder:



diskusage C:\Users\user\Downloads /hof the Downloads
folder:

diskusage C:\Users\user\Downloads /h



The command in this example generates a report indicating
how much disk space is being utilized at the current
location:

/h diskusage

When wusing /h, the size will be shown in a more
approachable format, such KB, MB, or GB.

To identify files larger than 4GB, use the following command
and press use.:

min diskusage
Path/TO/LOCATION /h FileSize=FILE-SIZE-KB

This command, for example, will look for and list files
greater than 15 MB in the Downloads folder:

min diskusage
C: Users User Downloads /h FileSize=1966080

Ed Admi m + v

To list the top files on the disk for a given location in
decreasing order of size, use the following command:

diskusage PATH/TO/LOCATION /h /Ju=NUMBER

In the command, replace "PATH/TO/LOCATION" with the
location you like to examine and "NUMBER" with the
quantity of files you wish to see.

For instance, the top ten files in the system32 folder are
shown with the following command.:

diskusage C:\windows\system32 /h /u=10



To list the top folders on the disk for a given location in
decreasing order of size, use the following command:

diskusage PATH/TO/LOCATION /h /t=NUMBER

To investigate a location, replace "PATH/TO/LOCATION" with
its address, and change "NUMBER" to the number of folders
you wish to view in the command.

The top ten directories in the system32 folder, for instance,
may be seen by using the following command:

diskusage C:\windows\system32 /h /t=10

+

You will be able to comprehend how files in a certain region
take up space after you have finished the stages. To see a
list of every option and its explanation, you may also use
the diskusage /? command.

A Windows 11 Feature
That Frees Up Disk Space



for You Automatically

Use this Windows 11 application to manage your online
storage, delete temporary files, and automatically clear up
space.

A computer with little to no useable disk space is something
you never want. Your computer will suffer from a full hard
drive; it will undoubtedly slow down, and your programs will
crash and freeze more often.

Even while cleaning up your disk is an obvious answer,
choosing which things to remove might be challenging.
Thankfully, Windows 11 makes it easy to delete things that
you no longer need and free up disk space on your
computer.

Rather than relying on third-party apps to clear off disk
space, Windows 11 has many options that let you quickly
remove system and temporary files as well as older
downloads that you most likely don't need.

If you're concerned about deleting critical files, don't be;
Windows 11 will assist you in determining which files to
delete in order to optimize your PC's efficiency.

How to Free Up Storage
Space Automatically on
Windows 11

On your Windows 11 PC, go to Settings > System > Storage.
If this is your first visit to this option, wait a few seconds as
your computer scans your data storage. You will be able to
view your total RAM free at the top of the page after
Windows has collected the necessary data. Your storage is
broken down into categories below: programs and features,



temporary files, and others. Selecting Show additional
categories will also provide you with a more thorough
examination.

Our focus is on the Storage Sense feature, which
automatically increases your computer's storage space
when it becomes low. It does this automatically in the
background by deleting temporary files, clearing your
Recycle Bin, and getting rid of outdated downloads.

Storage management

To activate Storage Sense, just flip it on here. To set up a lot
of features, just click the setting:

Put Storage Sense into Practice: Use Storage Sense on a
daily, weekly, or monthly basis, or whenever your disk
space is low (by default).

Remove files that have been in my recycle bin for longer
than: Select from one day, fourteen days, thirty days (the
default), or sixty days.



Configure cleanup schedules

Run Storage Sense

During low free disk space (default)

Delete files in my recycle bin if they have been there for over:

30 days (default)

Delete files in my Downloads folder if they haven't been opened for
more than:

Never (default)

Run Storage Sense now

Select from the
following options if a file in my Downloads folder hasn't
been accessed in more than: Never (the default), One Day,
Four Days, Thirty Days, and Sixty Days.

You may make sure that no important data are deleted from
your computer by controlling which files are erased and
when they are removed using the Storage Sense settings.

By selecting Run Storage Sense at the bottom of the page,
you can start using the function right away.

Use the Cleanup recommendations tool, which is located
under Storage Sense, if you need to remove additional files
in order to make room. When you click it, an analysis of your
system will be performed, and items such as temporary
files, large or worthless files, files synchronized with your
cloud, and unnecessary apps will be recommended for
manual deletion.



DISABLING OR ENABLING
CORTANA IN WINDOWS 11

Microsoft's official digital assistant Cortana replaced Apple's
Siri and Google Now when it was debuted with Windows 10.
Even while the program is very helpful, concerns about user
privacy it raises should not be disregarded.

Maybe for that reason, Microsoft opted not to include it in
the next Windows 11. Microsoft hasn't completely removed
Cortana, either; it's just turned off by default. For others,
however, Cortana is too precious to lose. And you should not
fear if you fall into such category.

We will cover how to turn on (and off) Cortana on a Windows
11 computer.

How to Make Cortana
Work in Windows 11

To activate Cortana on Windows 11, follow the instructions
below if you don't mind voice assistant privacy issues,
because trust us, there are many. Remember that Cortana is
installed by default as well, so all you have to do is turn it
on

1. Enabling Cortana from
the Start Menu Search Bar

On Windows 11, you may activate Cortana right away
simply typing her name into the search bar on the start
menu. Here's how to make it happen:

To use Cortana, type her into the Start menu search field
and then choose Best match.



Let's get you signed in

When the Cortana app opens, choose Sign in, then log in
using your Microsoft account.

To complete, click the Accept and Proceed button.

You will be signed into your Cortana account if you do this.
After that, the app will be opened.

2. Enabling Cortana Using
the Task Manager

Let's say the app doesn't start for whatever reason using
the previous technique. If so, you may use the Task Manager
to do something along those lines. A tool called Task
Manager is meant to keep an eye on the applications and
processes that are active on your Windows computer.
Applications may also be managed or terminated with its
help.

Therefore, turning on Cortana in Windows 11 will be
advantageous. To begin, do the actions listed below:




Ctrl + Shift + Del will choose Task Manager. Or, press and
hold CTRL, Shift, and ESC.

Next, click on the Startup tab.

Right-click on Cortana to bring up the list of choices.
Then, choose Enable from the menu.

How to Turn Off Cortana in Windows 11

If you've had enough, you can simply deactivate Cortana by
using the same procedures you used to install it, along with
a few other useful tricks we'll discuss below. Let's look at
each one separately.

1. Disable Cortana Using the
Windows Registry

The Windows Registry is a hierarchical database that the
operating system periodically checks for system-critical
files. The Registry will ultimately need to be accessed by the
kernel, user interfaces, and device drivers.

The Windows Registry is your best option if you want to
permanently deactivate Cortana. We presume you have
previously backed up all of your Windows data before



navigating the Registry. Do not misunderstand: modifying
Registry settings carries some risk.
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Once you've created a computer backup, here's how to
proceed:

Hit Win + R to open the Run dialog box.
Enter "regedit” there and hit Enter.

Enter the following in the address bar of the Windows
Registry when it opens:

Microsoft\Windows\Software\Policies\HKEY LOCAL MACHINE

Choose New > Key when you do a right-click on the
Windows folder.

The newly created key is called "Windows Search."

Right-click on Windows Search and choose New > DWORD
(32-bit).

Rename AllowCortana after creating it.

Start AllowCortana and set Value to 0. Select OK. Restart
your computer to finalize changes. This disables Cortana
permanently on your machine.

If you try to open Cortana again from your computer, this is



Cortana is disabled

what you'll see.

But what if you want to bring Cortana back to life? Not to
worry. To allowCortana again, all you need to do is set the
Allow Cortana file's Value data back to 1.

2. Using the Group Policy Editor in
Disable Cortana

Important Windows settings called Group Policy Settings
may be customized using a Windows administration
application called Group Policy Editor. One component of



Windows that allows you to manage how user and machine
accounts are utilized to operate Windows is called Group
Policy.

You may use Policy Editor to turn off the Cortana
application. To get started, adhere to the guidelines below:

Hit Win + R to open the Run dialog box.
In the Run dialog box, type 'gpedit.msc' and hit Enter.

Choose Windows Components > Administrative Templates >
Computer Configuration > When the Group Policy Editor
opens, do a search.

From the Search folder in the right pane of the dialog box,
do the following actions:

The "Allow Cortana" policy file may be found and right-
clicked.

Click Apply after selecting the Disabled radio option.

Windows 11 will come with Cortana deactivated. You may
re-enable "Allow Cortana" by simply changing it back to
Enabled, which will restore your previous configuration.

3. How to Turn Off Cortana Iin
Windows Settings



In Windows 11, you may now choose to deactivate Cortana
via the Settings menu. Start by adhering to the guidelines
listed below:

Type "settings" into the Start menu search field, then
choose "Best match." As an alternative, you may open the
Settings menu by simultaneously pressing Windows Key and
.

Apps > Apps & features > Cortana

Background apps permissions

Let this app run in background

Runs at log-in

These startup tasks can be configured to run when you log-in

I
Go to Apps > Apps & Features.

The Cortana app will show up when you put "cortana" into
the app list search area. Right-click on the Cortana
selections (three aligned dots) to choose Advanced options.

Locate and disable the toggle button next to the Runs at
log-in option.

Your copy of Windows 11 will have Cortana successfully
deactivated if you follow all of the following instructions.
Turning on and Off Cortana on Windows 11

That's all it takes, folks. Now that you are aware of every
secure method, you may modify your Cortana settings on
Windows 11.



DIFFERENT WAYS TO OPEN
SETTINGS IN WINDOWS 11

To change the appearance and functionality of your
operating system, use the Windows 11 Settings application.
Though many of Windows 11l's methods for accessing
Settings are similar to those in Windows 10, the app is
substantially different from Windows 10 with a more
appealing layout and a better overview of the available
choices and menus. Continue reading to learn about the
eighteen various ways you may access Settings in Windows
11.

First and foremost: Concerning the Windows 11 Settings

In comparison to Windows 10, Microsoft significantly
improved the organization and usability of Settings in
Windows 11. The Windows 11 Settings app is simpler, more
attractive, and much more helpful. There's always a
navigation pane showing on the left, in place of the
dashboard. This makes it simpler to find the options you
need by giving you faster access to the categories that are
accessible. Moreover, any important information can be
quickly seen at the top of the right pane, which also has




sections that can be folded to help you navigate the
Windows 11 Settings.

Learn about keyboard shortcuts and all the other methods
to access Settings in Windows 11 by reading on.

1. How to Use a Keyboard
Shortcut to Access
Windows 11 Settings

If you like using keyboard shortcuts, pressing Windows + | is
the fastest way to open the Settings app on Windows 11.

Home PgUp Mav
1 2 3 4 5 6 7 8 9 0 -

q w e r t y uli |o p Del End PgDn MvUp
\
Caps a s d f g h ] k | nter Insert Pause MvDn

Shift i X ¢ v b n m /™~ shift PrtScn  Scrtk Dock
/

SIS | o B R R

The Settings app appears immediately.



2. Using the WinX menu,
enter Settings in Windows
11.

Press the Windows key + X keyboard shortcut to open the
WinX menu. Alternatively, you may press and hold the Start
button or use a right-click. Next, hit the N key on your
keyboard, select Settings, or touch Settings.
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3. How to use the Start
Menu shortcut to reach
the Windows 11 Settings

Windows 11's Start Menu has also been altered, albeit the
Settings app is still accessible from it. Use the Windows key
to get started, or click or press the Start button. The Start
Menu has the Windows 11 Settings shortcut pinned by
default. Press or swipe the recognizable gear symbol.

If you are unable to locate the shortcut, don't panic! There
are other ways to open Settings from the Start Menu than
this one. You may restore this shortcut by following the
instructions in the chapter on pinning the Settings app to
the taskbar.
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4. How to Access Settings
from the Start Menu In
Windows 11 List of all
apps

Start by launching the Start Menu, as mentioned in the
previous chapter. Next, click or tap All applications in the
upper-right corner.



Realtek Audio Console

se
Simplenote
New
Skype
1. Slack
S Ne:
€ smanwmi e Settings
o Snip & S|
2 New
Snipping T
®  Ne
B stdynotes
T
N TeamViewer
R O

When you get to the letter S in the list of installed apps,
scroll down. Select or click Settings after that.

Pinned

2 8 ® B &8

Calendar Microsoft Stor Settings Calculator Notepad '
Wor

@ B 0 ~ H

qBitto presso  Opera Browser  Simplenote  TeamViewer

Firefox

Recommended

ssssssss



5. How to enable and use
the Windows 11 Start
Menu Settings folder
shortcut

In Windows 11, you may set the Start Menu to show a
Settings shortcut next to the power button. Click or touch
the app to open it.



6. How to Use Search to
Access Windows 11
Settings

on Windows 11, you may use the keyboard shortcut
Windows + S or click or touch the magnifying glass icon on
the taskbar to access the search. Additionally, you may start
typing in the "Type here to search" area at the top of the
Start Menu by clicking or tapping it.



Enter settings in the search window, using whichever
method you choose. Next, choose the app name in the left
column by clicking or tapping on it, or click Open in the right

pane..

£ settings

7. How to Pin the Settings
App to the Taskbar In

Windows 11



Until everything in your new operating system is precisely
the way you want it, you may find yourself using the
Windows 11 Settings menu a lot at first. Therefore, it could
be a good idea to pin the application to the Windows 11
taskbar. To locate the program, follow the instructions in the
previous chapter. Then, utilize the right pane to "Pin to
taskbar." By right-clicking or by pressing and holding on the
relevant search result, you may also access the same
choices.
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We go over how to press and hold or right-click on Settings
from the list of all applications in a previous chapter of this
book. Next, choose More, and then click or tap "Pin to
taskbar."
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Furthermore, you may open a contextual menu by right-
clicking or pushing and holding on the Settings app if it is
pinned to the Start Menu. Afterwards, choose "Pin to
taskbar."
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At any time, you may access the Settings menu by using the
taskbar shortcut.
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8. How to Make a Desktop
Settings Shortcut

You may quickly make a desktop shortcut to the Settings
app if you'd like. Right-click or press and hold on a blank
space on your desktop to bring up the right-click menu.
After choosing New, click or touch Shortcut.

. Create Shortcut
What item would you like to create a shortcut for?

This wizard helps you to create shortcuts to local or network programs, files, folders,
computers, of Internet addresses. 3

Type the location of the item:
rrrrrrrrr + @ F—

Click Next to continue.




When prompted to create a shortcut, enter ms-settings: as
the item's location. Next, you may touch or click.

« Create Shortcut

What would you like to name the shortcut?

Type a name for this shorteut:

settnd ( )

Click Finish to create the shartout

e Finish Cancel

After naming your new shortcut, click or tap Finish.



You may now use the recently established desktop shortcut
to visit the Windows 11 Settings.

" A |
=] Run X

Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you.

Open: ‘ms-settings:\ ﬂ
e oK ‘ Cancel Browse...

9. How to Access Settings
in Windows 11 Run

Using the Run window is an additional method to open the
Windows 11 Settings application. To insert ms-settings: into



the window, use the keyboard shortcut Windows + R. Next,
click/tap OK or hit Enter on your keyboard.

.10. How to open
Settings in Windows 11 from PowerShell, CMD, or Windows Terminal
You'll be happy to hear that PowerShell, Command Prompt,
or Windows Terminal may all be used to access Settings in
Windows 11, should you be partial to command-line
environments. Open ms-settings: and, regardless of the app,
CLICK on Enter on your keyboard.

Windows 11 opens the Settings app when you hit the Enter
key.
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11. How to Use the Quick
Settings Flyout to Access
Windows 11 Settings

To reach the Quick settings (located in the lower-right corner
of the screen) in Windows 11, use the keyboard shortcut
Windows + A or click/tap on the network, volume, or battery
icons in the system tray. Next, choose the gear icon located
in the Quick Settings flyout's lower-right corner by clicking
or tapping on it.



12. How to Open Settings
from File Explorer Iin
Windows 11

Additionally, File Explorer offers a simple method to open
the Windows 11 Settings menu. Launch File Explorer to get
started. Next, put ms-settings: into the address box and
press the Enter key on your keyboard.
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13. How to Open Settings
in Windows 11 via File
Explorer

You may easily quickly reach the Windows 11 Settings menu
using File Explorer. Start by opening File Explorer. Next, put
ms-settings: in the address box and hit Enter.
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As a result, the "New Task" window appears. Enter ms-
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14. How to open Settings
from the desktop's
contextual menu in
Windows 11

On the desktop, right-clicking or pressing and holding will
bring up a contextual menu. Click or tap Display settings or
Personalize to access Settings.

The left pane makes it simple to access the necessary
options, even as this begins the application in the area you
choose.



(03 Taskbar settings

15. How to use the
contextual menu iIn the
taskbar to access
Windows 11 Settings

You may still access Settings from the Windows 11 taskbar if
the application does not have a unique shortcut pinned to it.



To display a single-item contextual menu, either right-click
or press and hold a vacant space on the taskbar. You may
click or tap on it. This opens the Windows 11 Settings
program. From there, you can use the search box or the left
pane to get to the relevant area.
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16. Open Settings for
Windows 11 using the
system tray icons.

In Windows 11, you may launch Settings from the
contextual menus of some system tray icons. Two choices
are available when you right-click or hold down the clock in
the lower-right corner of the screen: Notifications settings
and Adjust date and time. Click or touch on one of these to
launch the Windows 11 Settings application.

Py

3 Power and sleep settings
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Alternatively, you may press and hold or right-click the
battery icon to choose "Power and sleep settings."



Troubleshoot sound problems

i§3 Open volume mixer

3 Sound settings
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When you right-click or press and hold the speaker icon, two
contextual menu choices appear: Sound settings and Open
volume mixer. Kindly click or tap one of these.
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Pressing and holding the network icon or performing a right-
click will take you to the "Network and Internet settings"
menu. In order to access Windows 11 Settings, click or press
on it.
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Click or press the icon for the language of the keyboard that
is now shown, and then choose "More keyboard options"
from the contextual menu.

Add a Bluetooth Device

Show Bluetooth Devices

Send a File
Receive a File

Join a Personal Area Network

Open Settings

Remove Icon
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~ B 0 0 & =wn 2o @ 8/2/2021

Whether you click, touch, right-click, or press and hold the
Bluetooth symbol, you receive the same contextual menu.
Click or tap Add a Bluetooth Device, Show Bluetooth
Devices, or Open Settings to open the Windows 11 Settings.



Open settin gs.

17. Instruct Cortana to
launch the Windows 11

Settings app.

If you like using Cortana, you can also ask her to open
Settings. Once Cortana has confirmed that she is listening,
type or say "Open settings." In response to your order,
Cortana displays and says, "I'll open Settings..."



18. How to Access Control
Panel Settings

Even though this third option is ineffective unless you spend
a lot of time in the Windows 11 Control Panel, we
nevertheless included it. Start the Control Panel by going to
its location and choosing the relevant option.



Select "Change account type" by clicking or tapping on it in
the Control Panel window's User Accounts section.

Next, touch or click the "Add a new user in PC settings"
option toward the bottom.

In Windows 11, you can also access the Settings app from
the Control Panel by clicking on additional links such as

these:



Add a new user in the PC settings by going to User Accounts
-> Remove User Accounts.

Change my account settings in PC Accounts -> Accounts ->
Manage another account -> User Accounts -> User Accounts
-> Make a new user in the computer's settings.

System and Security -> Security and Maintenance ->
Recuperation -> Try restoring your computer by clicking on
Settings if it's performing strangely.

System Taskbar and Navigation > Appearance and
Personalization -> Security and System

Switch on or off Extreme contrast in the Personalization and
Appearance (under the Ease of Access Center)



CONTROL PANEL IN WINDOWS
11

Microsoft is moving its emphasis away from Control Panel,
which might mean its extinction is imminent. With its better
navigation, usability, and setup, the recently revamped
Settings menu has rendered the feature almost redundant.

But the change comes at an excruciatingly slow pace. Even
though Windows 11 makes it harder to locate the Control
Panel, it still has several helpful functions. If you're an
ardent user of the program, here's how to access Windows
11's Control Panel.

1: Using the Search
Feature in Windows 11 to
Access the Control Panel
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most helpful features is without a doubt Windows Search,
which also happens to be the easiest method to open the

Control Panel.

Just take these easy steps to access the Control Panel:
Click the magnifying glass icon on the taskbar.

Now put Control Panel into the search field.

It displays the Control Panel app under Best match.

To access the Control Panel, click it.

It is worth noting that Microsoft has taken further steps to
facilitate consumers' transition to the new choice, since the
Settings app now appears within the Control Panel right

away.



2. Using Settings to
Access the Control Panel
in Windows 11

Whether it is for system settings access or customization of
the Windows experience, users have grown to rely on the
brand-new Settings app in Windows 11.

It is, after all, easier to access and start modifying since it
replicates Control Panel functions and is shown more
conspicuously.

However, we won't criticize Control Panel if you enjoy it. Just
take these easy steps to open the Control Panel via Settings:

Q System

Click the
taskbar's leftmost Start menu icon to get started. You may
also use the keyboard shortcut Win + 1.

Look for the Settings app and open it.

Enter Control Panel into the settings search area.

Press the Control Panel widget once it appears in the list
below.



3. Using the File Explorer
Address Bar to Access the
Control Panel in Windows
11

The majority of people are not aware that they may utilize
the File Explorer address bar to access the Control Panel.
This simple technique is useful if you use File Explorer a lot.

You may access Control Panel from the File Explorer in three
easy steps:

By right-clicking the Start menu icon, choose File Explorer.
You may also use the shortcut Win + E.

Click the furthest left caret button in the address bar.
Select the Control Panel option from the drop-down menu.



@ Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

control

[ 0K ] Cancel Browse..

4. Using the Run Menu to
Access the Control Panel
in Windows 11

You can start any app quickly using the Run menu. It may be
used to go to the Control Panel as well.

To get started, do these actions:



Tap Win + R to bring up the Run menu.
Insert control into the search box.
Press OK.



5. Accessing the Control
Panel From the PowerShell
in Windows 11

EX Administrator: Windows PowerShell = 0 ¥

There is

also a less common approach to access the Control Panel by
using a Command Prompt. If you like to run PowerShell
commands or are a programmer, this is perfect for you.

These easy steps will show you how to utilize PowerShell to
access the Control Panel.

In Windows Search, type PowerShell into the search area.
Type control next to the prompt in the PowerShell window.
Press Enter to open Control Panel.

6. Using the Start Menu
Windows Tools to Access

the Control Panel in
Windows 11



# il — IAII advanced user and
system administrator tools from Microsoft have been
combined into a single folder called Windows Tools. It allows
users to access Control Panel and other system utilities from
Windows utilities.

To use Windows Tools to access the Control Panel:

Get the Start menu open.

Click on All applications in the upper-right corner.

From the list of apps that displays, choose Windows Tools.
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To access the Control Panel, double-click on it within the
Windows Tools folder.



7. Accessing the Control
Panel Using Task Manager
in Windows 11

Here's how to access this powerful feature in Windows 11 if
that's your preference.:

v |V\Up! v l‘Ely uw lt[:’
30%  pRoMR nMARL 0 Mbne o Low Very
Create new task X
1.2% { Very low Very
0.1% Type the name of a program, folder, document, or Internet Very low Very
- resource, and Windows will open it for you.
0.5% ’ Very low Very
0% & Open: ‘ control Very low Very
0.1% 1 | Create this task with administrative privileges, Very low Very
0.1% 1 Very low Very
0% 1 0K Cancel Browse... Very low Very
0% A _ " Very low Very
0% 119MB  0.IMB/s 0 Mbps 0% Very low Very U se t h e

keyboard shortcut Ctrl + Shift + ESC to open Task Manager.
As an alternative, you may choose Task Manager from the
menu that displays by pressing Ctrl + Alt + Delete.

Tap on More information to see the Processes tab in
magnified view.

Select "Create new task" from the drop-down menu by going
to File.

Press OK after entering control. The Control Panel will open
as a result.

8. Making a Control Panel
Icon for Your Windows 11
Desktop
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Having the
Control Panel's icon on your desktop can greatly simplify
your life if you use it regularly. By following the instructions
below, you may add a Control Panel Icon to your Windows
11 desktop.

Navigate to Settings > Personalization > Themes to see the
available themes.

Find Desktop lcon Settings under Related choices. It will
open in a dialog box when you click it.

Persona lization > Themes -
.

----------

Check the box next to Control Panel and hit OK.



The Control Panel icon will now appear on the desktop.



9. Creating a Windows 11
Custom Control Panel
Shortcut

Creating a shortcut for Control Panel allows you to place it
wherever on your Windows computer, as opposed to the
prior option that only allows it to be on the desktop.

You could also find this method interesting if you want a
desktop that is clear of all papers and applications. To get
started, just create a Control Panel shortcut and place it
anywhere on your computer.

em would you like to create a shortcut for?

Thes wizard helps you to create shortcuts to local or network programs, files, folders, computers, or
nternet addresses

Type the location of the item:

ewindir %\ System 32\ control.exe

Click Next to continue

This more flexible
approach is as follows: right-click on any blank space on
your desktop and choose New > Shortcut from the context
menu.

Enter %windir%System32control.exe under Type the item's
location.

Click Next to continue, and give the shortcut any name you
like (for example, "Control Panel").

Select Finish.



10. For easier access, pin the Control Panel to the Taskbar.

® Windows Tools

B System

¢ BitLocker Drive Encryption

' Turn Windows features on or off
' Uninstall a program

§ Mouse

¢4 Control Pane

7 Pinto taskbar
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X Close all windows
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it requires just one effort gives it an edge over the other
ways. After you've pinned Control Panel to your taskbar, you
won't ever have to bother about searching for the folder
using multiple methods.

You may combine this step with any of the other mentioned
options. Choose how to open the Control Panel, then right-
click on the app's taskbar icon and choose Pin to taskbar.

Control Panel Isn't Extinct
Yet

Microsoft can't completely demolish the Control Panel just
yet, but we know that's what it wants to do. Control Panel
will not be considered obsolete just yet since certain
settings are still exclusive to it, and that won't change until
Microsoft manages to move them over to the Settings app.



CREATING AND ADDING NEW
USER IN WINDOWS 11

Do you currently have a copy of Windows 11 installed, or did
you get it already? Windows 11 will ask you to establish a
new user account if you need to share your machine with
other people. If so, you've come to the correct place. This
chapter will show you how to add and create a new user in
Windows 11. I'll show you how to add a local or Microsoft
account:

IMPORTANT: When establishing a Microsoft account, you
should utilize a web browser to carefully fill out all the
information, including the recovery details in case you ever
forget your password. Here are three methods for creating
an online Microsoft account. This section shows how to add
pre-existing Microsoft accounts to Windows 11 as well as
how to create and add local user accounts. Please be aware
that you must be logged into Windows 11 as an
administrator with the ability to add new users in order for
the instructions in this article to work.

1. Using the Settings app, create a new user in
Windows 11.




The Settings app allows you to add both Microsoft and local
accounts. To accomplish this, open the Windows 11 Settings.
One way is to use the keyboard's Windows + | keys.

Next, from the Settings app, choose Accounts and then
Other users. Your version of Windows 11 is out of date if you
can't see this option; choose Family & other users instead.

Adding more accounts to Windows 11 is now possible. In the
Other users section, choose "Add other user" by clicking or
tapping the Add account button.

The Microsoft account window appears when you use this
command. This article's Section 1.a explains how to set up a
Microsoft account in Windows 11. The steps to establish and
add a local account are outlined in Section 1.b.



How will this person sign in?

1.a. Adding a Microsoft account in Windows 11
Settings

Provide your Microsoft account number or email address and
hit Next when you want to add an account.

The Microsoft account has now been updated on your
Windows 11 computer. During the first login, its password
will be automatically prompted; hence, you won't need to
enter it. You're done after you click Finish.

You may now use that Microsoft account to log into Windows
11.

1.b. Adding a Local Account in Windows 11 Settings

Click or touch "I don't have this person's sign-in information"
in the Microsoft account box if you want to establish a local



(non-Microsoft) account.

Rather, Windows 11 attempts to let you register for a
Microsoft account. You may reject this offer by clicking or
tapping "Add a user without a Microsoft account."



Now, a local user account may be established. Type its
name and password, then make sure the latter is correct.
Note that you do not need to enter a password to log in.

You have to respond to three security questions below the
password fields if you input a password. They are
unavoidable, and their purpose is to let you retrieve your
local account password in the event that you forget it.
Choose the three questions you want to respond to, then
enter your answers. It is not necessary to respond truthfully
since Microsoft will not get this information. Once you're
done, press or click Next.

Decide which security questions to answer, then

After the local account is created, you are sent back to the
Settings app, where it can be found under the Other users
section.



2. Adding a Local Account Using the Terminal,
Command Prompt, or PowerShell

Use the following
command to open the Terminal as administrator if you
prefer command-line environments:

net user NAME PASSWORD /add

Replace "NAME" with the new user's name and "PASSWORD"
with the password. | created a user named MyUserName
and gave them the password Pas$$wOrd, as you can see in
the picture below. How secure do you believe that password
is?

NOTE: Without a password, the newly created user may log
in if the PASSWORD value is deleted from the command.
Moreover, you may use this command in PowerShell and
Command Prompt, whether you use the standalone apps or
open them in the Terminal.

3. Using Computer Management, create a new
user account in Windows 11.



Go to Computer Management. To do this, tap and hold the
Windows icon on the taskbar, or use the keyboard shortcut
Windows + X. From the menu that appears, choose
Computer Management.

Optionally, choose Computer Management by pressing
Windows + X.

In the center pane, right-click Users and choose New User
after double-clicking on Local Users and Groups in the left
sidebar.

The "New Users" popup appears. Fill in the User name and
Full name forms. If you'd like, create and confirm a
password. Uncheck the option labeled "User must change
password at next logon" if you do not want the user to have
to update their password each time they log in.



When you're done setting everything, click Create. Windows
11 adds and creates the user account.

ESSENTIAL. This approach works on all Windows 11
versions, with the exception of Windows 11 Home, which
does not have the Local Users and Groups option under
Computer Management.



—— 4. USING Netplwiz, how can
| add or create a new user?

To get started, open the Run window by using the keyboard
shortcut Windows + R. Type or copy and paste the following
command:

netplwiz
Next, click/tap OK or hit Enter on your keyboard.

All of the user accounts on your computer are listed in the
User Accounts box when it displays. To add a new user (local
or Microsoft account), click or press Add.

While Section 4.b explains how to establish a local account,
Section 4.a explains how to add a Microsoft account.

4.a. Using netplwiz to add a Microsoft user account

Enter the email address of the Microsoft account you want
to add, then click Next.

The email address linked to the Microsoft account you want
to add should be entered.
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Add a user
Let this person know they ll need to be connected o the Internet to sign in for the first
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There is a new user in Windows 11 that may be utilized to
log in. You only need to press the Finish button.



4.b. Using netplwiz, create a new local user account.

Ignore the warning from the firm that doing so is "not
recommended" and proceed to establish a new local
account by clicking or touching "Sign in without a Microsoft
account (not suggested)".

You are then presented with every advantage of owning a
Microsoft account.

The company is doing everything in its power to convince
you not to use a local account. After you've had a good
laugh, click or hit Local account.



Input a fresh login name, a password, and a clue for the
password. Next, you may touch or click.

After entering the new user's details, click Next. To complete
the process of adding a new user or local account, click
Finish at the end.

You will add the user when you click Finish.

Returning to the User Accounts page, you see the newly
created user account displayed among the existing ones.

TIP: The User Accounts panel may also be used to set up
Windows 11 so that you can log in without a password.



5. How to Add a Microsoft Account During
Windows 11 Installation

The creation of a Microsoft account will be required when
you install Windows 11. The user is created before you log in
to Windows 11 for the first time. Next, provide the phone
number or email address associated with that account.

After entering the details for your Microsoft account, click
Next.

If two-step verification is enabled for your Microsoft account,
you will be prompted to enter a code received to your phone
or another email address to authenticate yourself. You are
only prompted for your account password in all other
situations.




Click Sign in after that, and Windows 11 will add the
account.

Let's say you want to install Windows 11 and want to add a
local account. Since the procedure is a little more
complicated in such scenario, we have created a special
section to help you: installing and using a local account for
Windows 11.

Which approach do you prefer for adding a new user?

With Windows 11, you now have more choices when it comes to creating user
accounts, which should come in handy in a variety of situations. This covers all | could
think of to say about adding new users to Windows 11.



Installing and using Windows 11 with a local
account

Do you want to use Windows 10 Home without signing into
Microsoft? Would you want to install Windows 11 (Home or
Pro) using a local account? You can do these things even if
Microsoft overcomplicates things. The steps you need to
follow during Windows 11 installation and thereafter to
convert from a Microsoft account to a local offline account
are described in our guide. Okay, let's ready to go:

Windows 11 requires the use of a Microsoft
account by default.

Microsoft asks you to use a Microsoft account when you
install or customize a brand-new Windows 11 PC (Home or
Pro); setting up a local account is not mentioned. Once
Windows 11 Pro is installed or used, you will see a link that
says "Sign-in options."

The option to establish an Offline account, which is a simple
local account similar to those used in Windows 7, will appear
if you click or push on it.

But Windows 11 Home does not include Sign-in choices, and
you cannot advance unless you register for a Microsoft
account.



Installing Windows 11 with a local account

Once you've followed our How to Install Windows 11 from a
USB, DVD, or ISO instruction, name your device, input it,
click Next, and proceed as directed.

Once you have the device name input, stop and carefully
pay.

Use the keyboard shortcut SHIFT+F10 to launch Command
Prompt. In the Command Prompt window, enter the

following command: taskkill /F /IM
oobenetworkconnectionflow.exe

Hit Enter to run the command. Should you see the word
SUCCESS, as shown in the image below, the networking
service that the Windows 11 setup utilized to establish a
connection with Microsoft's servers is ended.



As a result of its inability to establish a connection with
Microsoft's servers, Windows 11 now asks you to enter the
name of the user who will be using your computer. This is
not a Microsoft account; instead, it is a local account.

Fill in the name of your local account.

After setting the security questions and entering the local
account password, you may proceed with the regular
Windows 11 customizing procedure.

How do | use Windows 11
if | don't have a Microsoft
account?

If you currently have Windows 11 (Home or Pro) installed
and configured with a Microsoft account, you may change to
a local account and remove your Microsoft account:

Use your existing Microsoft account to log in. It ought to
have access to the administrator dashboard.



Set up a local account.

New accounts are created by Windows 11 as regular
accounts without administrator capabilities. Set the account
type of the recently created local account to Administrator.

Customize your just created local account as you see fit by
changing the desktop background, installing and configuring
all of your programs, and more.

After the local account is active, delete your Microsoft
account from Windows 11 by following the steps outlined in
this section: Methods for Removing a Windows Account.

Add a user without a Microsoft account to Windows 11.

Congratulations! As of right now, Windows 11 is being used
on a local offline account that doesn't send any personal
data to Microsoft.



How to remove an account from Windows

Is it required to delete a user account from your Windows 10
or Windows 11 computer or device? Maybe a certain user
has contaminated himself, or you want to stop them from
accessing your computer. Regardless of whether you wish to
remove a local account or a Microsoft account from
Windows, this guide will walk you through seven different
methods for doing so. Find out what suits you best by
reading on:

IMPORTANT NOTE: This tutorial's processes need the use of
an Administrator account. Using an administrator account to
erase another account is the main concept.

1. Using the Settings program,
remove a user account in Windows
11.

In our view, the easiest way to remove a user account in
Windows 11 is using the Settings tool. Press Windows + | on
your keyboard to open Settings first. Next, choose Accounts
from the sidebar on the left.

Next, choose "Family & other users" from the drop-down
menu on the right.



Go to the Settings box's right side and find the user account
you want to remove. It ought to show up under Other users.
After making your selection, click or press the Remove

button.




ccounts > Family & other users

You are notified via a pop-up that when you cancel the
account, all of the user's data is removed from your

computer. To initiate the deletion process, choose "Delete
account and data."

In Windows 11, the user account and all of its contents are
automatically removed.

2. Using the Settings app,
remove a user account in
Windows 10.

In Windows 10, the process for eliminating a user account is
the same. Click on Settings (Windows + 1) to open the
Settings dashboard, then choose Accounts.
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On the window's left side, click or touch "Family & other
users."




On the right, find the user account that you want to remove.
Next, select it and hit the Remove button.

Family & other users

After that, Windows 10 asks you whether you want to
"Delete account and data."




3. How to Remove a
Windows Account Using
the Control Panel

Files belonging to the user are retained when you remove an
account using the Control Panel. Open Windows 10 or
Windows 11 Control Panel, then click or touch User
Accounts.

In the User Accounts section, click or touch the "Remove
user accounts" link.

Click on Remove user accounts.



This brings up a list of user accounts that have been found
on your Windows device or computer. Select the account
that you want to remove.

To remove a user account, click or press on it.

This enables you to modify the chosen account. From the list
of actions on the left, choose "Delete the account."




You are prompted to decide whether to retain the user's
files. All information associated with that user account is
erased when you choose Delete Files. Alternatively, you may
choose Keep Files, which relocates the user files for that
account to a desktop folder with the account name.

Select which files to preserve or remove.

You have to provide your approval for the user account to
be deleted if you decide to Keep Files. Once you choose
"Delete Account," you're done.

Verify that the account has been deleted.

The files will be kept on your desktop in a user-named folder
if you want to retain them.
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= Type the name of a program, folder, document, or Internet
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4. How to Delete a
Netplwiz User Account

Using the netplwiz application is an additional method for
removing an account from Windows 11 or Windows 10. To
get started, type netplwiz into the Run window by using the
Win + R keyboard shortcut. Next, click OK or hit Enter on
your keyboard.

| User Accounts X

Users  Advanced

@ Use the list below to grant or deny users access to your computer,
%) andto change passwords and other settings.

Users for this computer:

User Name Group

Add...

Remuveo Properties

To change the passward for Remote Citizen, click Reset
Wy Password

Password for Remote Citizen

Reset Password...

This opens the Users tab in the User Accounts window. Click
or touch Remove after selecting the account that needs to
be deleted from the list.



Click or touch Yes in the following pop-up window to confirm
your choices.

To confirm deactivating your account, click Yes.

5. How to Remove a
Windows Account Using
Computer Management

Using the Computer Management application, you may also
delete an account from a device or computer running
Windows Pro or Enterprise version. Click or press the arrow
next to "Local Users and Groups" under System Tools after



selecting Computer Management to see its contents. Next,
choose the Users folder from the main pane.
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8 Remote Citizen
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Next, choose the user you want to delete by doing a right-
click or holding down the mouse button.
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Within the contextual menu that displays, click or hit Delete.
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To verify your selection, press or click the Yes button on the
POp-up.



6. Using Command
Prompt, remove a user
account on Windows
(CMD)

Launch Command Prompt as administrator to get started. In
the CMD window, type net user "username" /delete.

Put the name of the
user account you want to remove in lieu of the username.
Next, hit Enter on your keyboard. We used the command net
user "Remote Citizen" /delete to terminate the Remote
Citizen user account.

The account is immediately deleted from Windows.



7. Using PowerShell,
delete a user account from
Windows

If you'd like, PowerShell may be used to delete an account
from Windows as well. Open PowerShell or Windows
Terminal as an administrator. Type the following after that:

- Title "username" Take-LocalUser Out

Substitute the username with the name of the account that
is going away. Next, press the Enter key.

Even if PowerShell doesn't ask for confirmation, the account
is closed.

On your Windows machine, did you erase any user
accounts?

Regularly, I empty out any accounts that I'm not using to
make room on our Windows desktop computers and other
devices.



DIRECTIONS FOR SETTING UP
FOLDERS IN WINDOWS 11
STARTING MENU

Start menu folders have been reinstated by Microsoft with
the Windows 11 upgrade for 2022.

In Windows 10, you may create and manage folders to keep
programs in your Start menu.

This will keep your applications neatly arranged and prevent
the menu from being too busy. That feature was not present
when Windows 11 was introduced.

That feature has been restored by Microsoft in the most
current version of Windows.

To better organize certain programs, you can create, move,
and manage folders in the Start menu with the Windows 11
22H2 update.

How to Use Folders to Organize Your Windows
11 Start Menu

1. Upgrade your Windows 11 PC to
version 22H2.

First, upgrade your Windows 11 PC to the 22H2 version if
you haven't already. To check for updates, go to Settings >
Windows Update and choose the button. If you would want
to install the 22H2 update on your PC even if it isn't
currently available, visit Microsoft's Download Windows 11
page. Here is where you may get the update via an ISO file,
the Windows 11 Installation Media, or the Windows 11
Installation Assistant.
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2. Press the Start button.

Press the Start button to open the menu. You should pin any
often used programs that aren't on the Start menu so you
can organize them into folders. Click the All Apps button at
the top. To pin an app, right-click on it and choose Pin to
Start from the menu.



3. Look for apps to
organize into folders.

Go back to the Start menu and search for the programs you
want to file into folders. Search for programs that are
associated with online browsers, picture and video editors,
utilities, or Microsoft Office. Drag one icon across another to
create a folder.




4. Modify the folder's
name

The following two programs will be installed in a folder
named Folder. Click on the folder to open it. In the Edit
name area, give the folder a new name. Next, click anyplace
to shut the folder and verify the new name from outside of
it.

5. Keep adding apps to the
folder.

To add more programs, drag and drop more icons that are
relevant on top of the folder. In this way, add more
programs to the folder.



6. As you continue to look
for other apps, select
"Move to front."

Next, search for more applications that you want to organize
into a folder. Here's the catch, though. What happens if the
programs in the Start menu are too far apart to be able to
drag & drop one on top of the other? When they can both be
positioned on the same row, there is no issue. Right-click an
app to bring it to the front. This shifts the symbol to the first
place in the top row.



7. Stack apps on top of
one anhother to make a
new folder.

Repeat with any additional programs you want to move into
the same folder so they are all arranged on the top row near
one other. When you're finished, make a new folder by piling
the programs on top of one another, which you should then
rename.



8. View the icons in a
folder by opening it.

Keep going until you've made every folder you desire. Open
a folder to see its icons. To put the icons in the desired
sequence, drag & drop them. Double-clicking an app will
launch it.



9. Move folders around
the Start menu with your
mouse.

Once you're done, you may move the folders about the
Start menu by dragging and dropping them. Right-click a
folder and choose Move to front to move it to the front row.



10. To remove an app from
a folder, open it and drag
the icon outside of it.

Lastly, you can just enter the folder and drag the app icon
outside if you want to remove it from a folder and put it on
the Start menu by itself. The folder disappears if you
uninstall all the programs but one.



FILE EXPLORER IN WINDOWS 11

Buttons in the Ribbon

The File Explorer in Windows 11 has been updated. In earlier
iterations of Windows, File Explorer was known as "Windows
Explorer". On the other hand, although they have somewhat
different names and functions in various Windows operating
systems, Windows Explorer and File Explorer are basically
the same application.

You may view and manage the files and folders on your
computer and in your OneDrive account using the File
Explorer window in Windows 11. For instance, in Windows
11, a File Explorer window displays the contents of a library
folder when you access it.

Click the "File Explorer" program icon on the taskbar to
launch File Explorer in Windows 11. To enter the Start menu,
you may also utilize the "Start" button on the Windows
taskbar. Next, if the "File Explorer" app icon appears in the
"Pinned" section of the Start menu, click it. Click the "All
applications" button in the top-right corner of the "Pinned"
section, navigate to the "F" apps in the alphabetical listing
of all the programs, and choose the "File Explorer" app icon
if it isn't visible.

In Windows 11, the Ribbon toolbar at the top of the window
contains buttons for File Explorer. You may perform various




operations on the files and folders you select in the main
File Explorer window by using these buttons. Let's take a
closer look at the many tools and features available in a
typical Windows 11 File Explorer window.

With Windows 11 File Explorer's Navigation pane, you may
choose disks and folders and browse to computers,
directories, and files on your network. Click the arrows to
the left of the titles of the sections and folders in the
Navigation pane to expand or collapse them. OneDrive, This
PC, Network, and Quick access are all common elements in
the Navigation pane.

Use the Back, Forward, and Up buttons in File Explorer in
Windows 11 to move between the different windows. Click
Back to go back to the previous folder. After hitting the Back
button, click the onward button to proceed onward. To
navigate up a level in the File Explorer window's folder
structure, click the Up button.

Common file and folder management commands are
available on the Ribbon, or toolbar, located at the top of the
File Explorer window. The available Ribbon buttons for an
item become active when you choose it from the Files and
Folders list in File Explorer.

The Address Bar displays the location of the currently
selected folder on your computer or network. Alternatively,
you may put a folder's location in the Address Bar and hit
the "Enter" key on your keyboard to open the folder in File
Explorer. The Files and Folders list displays the contents of
the Address Bar folder location that is currently chosen.

Selecting the "Details" mode and selecting a folder location
from the Address Bar causes the general File Explorer
window to display information about a folder's files and
folders in columns. Each column has a name at the top that
indicates the type of data that is included there.



To search for the text you input inside the currently chosen
folder location, click the Search field in File Explorer and
type the file or folder name, or just the first few letters in
the file or folder name. This will look for the text you type in
the chosen file or folder location. As soon as you start
entering in the Search Box, the search procedure begins.

Instructions for Using Windows 11's File
Explorer

Click the "File Explorer" program icon on the taskbar to
launch File Explorer in Windows 11.

To enter the Start menu, you may also utilize the "Start"
button on the Windows taskbar.

Next, if the "File Explorer" app icon appears in the "Pinned"
section of the Start menu, click it.

Click the "All applications" button in the top-right corner of
the "Pinned" section, navigate to the "F" apps in the
alphabetical listing of all the programs, and choose the "File
Explorer" app icon if it isn't visible.

Windows 11 features File Explorer buttons on a toolbar
called the Ribbon, which sits at the top of the window. You
may perform various operations on the files and folders you
select in the main File Explorer window by using these
buttons.

The File Explorer window's Navigation pane is used to
choose folders and drives as well as to navigate to
computers, directories, and files on your network.

Click the arrows to the left of the titles of the sections and
folders in the Navigation pane to expand or collapse
them.Use the Back, Forward, and Up buttons in File Explorer
to move between the different windows.

To get back to the folder you were viewing earlier, click the
Back button.



After hitting the Back button, click the onward button to
proceed onward.

To navigate up a level in the File Explorer window's
hierarchy, click the Up button.

Common file and folder management commands are
available on the Ribbon, or toolbar, located at the top of the
File Explorer window. The available Ribbon buttons for an
item become active when you choose it from the Files and
Folders list in File Explorer.

The location of the folder you are presently selecting on
your computer or network is shown in the Address Bar.

To type into the Address Bar, input the folder's location, and
then hit the "Enter" key on your computer to display the
folder in File Explorer.

The Files and Folders listing displays the contents of the
Address Bar folder location that is currently chosen.

Selecting the "Details" mode and selecting a folder location
from the Address Bar causes the general File Explorer
window to display information about a folder's files and
folders in columns. Each column has a name at the top that
indicates the type of data that is included there.

To search for the text you input inside the currently chosen
folder location, click the Search field in File Explorer and
type the file or folder name, or just the first few letters in
the file or folder name. This will look for the text you type in
the chosen file or folder location. As soon as you start
entering in the Search Box, the search procedure begins.

How to Customize File Explorer in Windows 11

File Explorer is among the nicest features of the Windows
operating system. Windows is what you'll use to manage
your files, access all of your software, and view what's on
your hard disk. File Explorer is therefore one of the most
important Windows 11 programs.



Microsoft revamped File Explorer for Windows 11. All of the
customization options are still there, but the way you may
access them has been modified. You may personalize
Explorer in many ways using those settings.

Change the size of the file and folder icons

Windows 11's File Explorer software features one additional
view choice in addition to all of the previous ones. You may
choose various icon sizes for the files and folders that are
shown in Explorer by using these view settings. Additionally,
you have a variety of layout options to examine the
contents of folders.

To adjust the size of the icons, click the File Explorer taskbar
button. Then, to see the menu below, click the View button
on Explorer's new command bar. Extra-large, big, medium,
and tiny icon sizes are available for selection.

The icon size parameters are immediately below the four
layout options. Explorer may be used to view files with
different list, detail, tile, or content layouts. By choosing the
List and Details options, you may view more date updated
and size information for files and folders.

You may activate the new File Explorer setting known as
Compact view by selecting that option. You may remove the
extra visual element padding that Windows 11 added to
Explorer by using this option. The graphic below illustrates
how the folder navigation on the left panel shrinks when you
choose it.



Panes, Item Check Boxes, and File Extensions
can be shown or hidden.

The View menu now features a new Show submenu. From
that menu, choose Show to view the choices as seen in the
image below. To display or conceal the Explorer features,
select the Navigation, Details, and Pane menu items.

There are three other notable customization choices located
below the pane options. Little checkboxes will show up next
to the files and folders you have chosen when you choose
the Item check boxes option. Explorer will add extensions to
all files in order to identify formats if you select File Name
Options. All files and folders that have been designated as
hidden are seen when you select the Hidden Items option.

Change the Icons of Folders

The folder icon pattern that Explorer uses by default is
rather uniform. On the other hand, folders may be
customized by altering their icons. By giving your most
significant folders fresh icons, you may make them stand




out more. In Explorer, you may modify a folder's icon in this
way.

In Explorer, right-click a folder and choose Properties.

General Shang Seculy Previous Versions Customise

Then, select the Customize button as seen immediately
below.

Choose the option to Change Icon.
From the System32 folder, choose a new icon for the folder.

Select the OK button.
Select the Apply button located on the properties window.



Go to websites like IconArchive, etc. to search for new File
Explorer folder icons outside of the System32 folder. You
may download and add as many of the eye-catching icons
from that website as you like to your folders. To locate new
icons, enter the term folders into the IconArchive search
box. To download one, choose it and click the ICO button.

Once you've downloaded some new icons, add them to your
Explorer folders by following the preceding instructions. On
the Change Icon window, though, you have to select
Browse. Next, click the Open option after choosing the
downloaded icon from a separate folder.

Modify the Advanced File and Folder Settings

Explorer's Folder Options box offers a plethora of additional
settings for both files and folders. You may fine-tune the
detail of how Explorer shows files and folders by selecting
the View tab in that window. You may customize how
Explorer shows files and folders by using Folder Options.

Click the "See more" (three dots) button in Explorer to bring
up the menu seen in the screenshot below.

Select Options by clicking the drop-down menu.
Then, select the View tab as indicated right below.

You may pick or deselect the advanced options to modify
the way Explorer presents files and folders.



Click Apply to preserve your modified settings.

Try selecting and deselecting different combinations of
those advanced options to see how Explorer shows folders
and files. then view the results by checking Explorer. You
may go back to the prior configurations at any time by using
the Restore Defaults option.

Enable single-click file and folder opening.

By default, double-clicking an item in Explorer opens it.
However, by choosing the Single-click to open an item
option, you may modify this. Explorer will open files and
folders when you single-click them. You may activate single-
click item opening in this way.

To access Folder Options, click the See more button, then
choose Options in Explorer.




Choose the Single-click to open an item radio button on the
General tab.

Next, choose the option to just highlight icon names when |
point at them or highlight icon titles consistent with my
browser.

Click Apply to preserve the updated configurations.
Click OK to close Folder Options.

Winaero Tweaker can be used to customize File
Explorer.

Try the free program Winaero Tweaker to further alter File
Explorer. That is a sophisticated customization tool that lets
you further personalize File Explorer to your preferences.
The Winaero installation and download procedures are as
follows.

Go to the website of Winaero Tweaker.

To download the Winaero Tweaker application in ZIP format,
click the Download option on that webpage.

Launch the File Explorer window.
After downloading Winaero ZIP bundle, open it.

Choose the Extract all option located on the Explorer
command bar.

Check the box adjacent to the choice When finished, display



the extracted files.
Click Extract to complete.

Next, double-click WinaeroTweaker-1.33.0.0-setup.exe in the
unpacked folder.

Follow the setup wizard's instructions to install the Winaero
Tweaker.



Launch the Winaero Tweaker application.

There are twenty-one customization settings in the File
Explorer area of Winaero Tweaker. Double-click File Explorer
on the window's left side to see its settings. Each setting is
fully described in Winaero Tweaker. The following are a some
of the more noteworthy Explorer customization options:

Custom Items: a configuration option that enables you add
user folders, system locations, and Control Panel applets to
the navigation pane.

Default Items in the Navigation Pane: Using this option, you
may remove certain default items from the Explorer
navigation pane.

Modify This Computer Folder: This feature allows you to
customize the icons for the folders on this PC.

Customize Quick Access Item: Using this option, you can
give the Quick Access item a new name and icon.

Customize Libraries Item: Click this button to rename and
alter the Libraries item's icon.

The ribbon tabs from the previous File Explorer may easily
be restored with Winaero Tweaker. Double-click the Windows
11 category in Winaero and choose Enable Ribbon to
accomplish this. Check the option to enable the Ribbon Ul in



File Explorer. Click the Restart Explorer button to make the
changes take effect.

The former View, Share, File, and Home tabs are no longer
visible in File Explorer. You may use the previously stated
customization options for Explorer on the View tab. Click the
Options button to bring up the Folder Options box.



Customize File Explorer to Your Preferences

Thus, there are several methods to configure File Explorer
using both third-party applications and its built-in settings.
The built-in customization settings allow you to modify how
Explorer shows files and folders. To the built-in Explorer
choices, the extra settings in Winaero Tweaker are also a
helpful addition. With so many personalization choices, you
can make Explorer just as you want it.




CONNECTING TO A NETWORK

The majority of users are logged onto their Wi-Fi networks. If
you pay your payments on schedule, this connection is
dependable, honest, and loyal. Ten years ago or less, Wi-Fi
was seen as a luxury. It is currently a requirement for all
forms of housing, including public and private ones.
Although it is necessary, we do not need it to survive. Our
survival in a digitally connected society depends on wireless
quality. In times of need, it serves as our ally, companion,
and rock.

If we weren't connected to Wi-wonderful Fi, all of its benefits
would be meaningless. Wi-Fi disconnections may occur after
recent device upgrades and installations. If, for whatever
reason, your Windows 11 device loses WiFi connectivity,
here are a couple methods to go back online.

Connect to Wi-Fi via the
Taskbar

y
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No internet access
Connections available

13:32
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The Wi-Fi,
Sound/Speaker, and Battery keys have been combined into
a single little transparent box called the quick settings,
which is located in the taskbar's lower right corner. The
cursor may be moved over each icon to view its own



preview. But when you click a single button in the box, the
options for each button show.

Click this transparent box to reveal the Wi-Fi settings.

Select the "Manage Wi-Fi connections" option by clicking the
right-pointing arrowhead next to the Wi-Fi emblem in the top
area of the options box.



Wi-Fi is off

Turn on Wi-Fi to connect to an available Vi§-Fi
network.

Turn Wi-Fi back on

Manually v

Click the toggle bar next to 'Wi-Fi' to turn on the network if it
isn't already on. It is necessary to switch on the Wi-Fi when
attempting to connect to one.

You will get a list of all accessible Wi-Fi connections when
you turn on the Wi-Fi. When you find the link you wish to
connect to, click ‘Connect'.
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If you wish to connect to the same Wi-Fi network later on,
check the box next to "Connect Automatically." Your device



will automatically establish a connection to the chosen Wi-Fi
network as soon as it is turned on.
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Secured

Enter the network security key

7N
Input the network security key or Wi-Fi password for the

selected network in the box next to "Enter the network
security key." Click the "Next" button after that.

You are presently connected to the Wi-Fi network you have
chosen.
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‘ More Wi-Fi settings

Click the "Disconnect" button that appears when you choose
a connected or stored Wi-Fi network in order to log off of any
network.

Disconnect
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Using the Windows Settings menu, connect to WiFi.

Click 'Start' on the taskbar, then choose 'Settings' from the
pinned items.



Alternatively, you may choose 'Settings' from the menu by

performing a right-click or double-click on the Windows
button.

Now the 'Settings' page will show up. On this page, choose
'Network & Internet' from the menu on the left.

........

On the 'Network & Internet' tab that displays on the right,
select the 'Wi-Fi' option. It'll be the first item on the list.
Make sure the Wi-Fi toggle is turned on before moving
further.



Network & internet

Not connected
@ You aren’t connected to any networks

) VPN

When you go to the 'Wi-Fi' menu, choose 'Show Available
Networks'.

Network & internet > Wi-Fi
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" show awailable networks
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A list of nearby Wi-Fi networks that are available will appear.
Once the desired connection has been selected and the

password or network security key has been entered, click
"Next".



Network & internet > Wi-Fi

You may also use this method in conjunction with the
‘Search' icon. On the taskbar, click the magnifying glass
icon, which represents the "Search" button. Enter "Wi-Fi" in
the search field that shows up above the "Search" box.
Choose "Discover WiFi Networks" from the search results on
the left (under "Best Match"), or click "Open" next to the
large app icon on the right.
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You'll be taken straight to the Wi-Fi configuration page as a
result. Pick the 'Show Available Networks' option to carry out
the preceding step.

Network & internet > Wi-Fi

D Wifi on @D

% Show available networks

:= Manage known networks

{1} Hardware properties

Random hardware addresses
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Your Windows 11 device is now WiFi-enabled.



Connect to Wi-Fi using the
Command Prompt

Press the 'Search' button located in the taskbar, input
'‘Command Prompt' into the search box, then select 'Run as
Administrator' from the menu to the right of the application
name.

When asked if you want to enable the program to make
changes to your system, click "Yes."

Use the command netsh wlan show profiles and hit Enter to
view the accessible WiFi networks.



™ Administrator: Command Promgt

Locate the desired wireless network in the User Profiles list,
then type its name after 'name=' in the subsequent
command.

wlan connect name = <user profile name> in netsh

You will be able to access the network of your choosing right
away. This method's drawback is that pre-connection is
necessary. You have to have connected to the wireless
network(s) at least once in order to show up in the 'User
Profiles' area.



Connect to a Hidden Wi-Fi
Network Manually in
Windows 11

Sometimes, for whatever reason, some Wi-Fi connections
won't show up under 'Available Networks' when you join to a
wireless network. It can be a network that is now out of
range or a secret network. Fortunately, you can always
manually connect to the WiFi network, so there's no need to
freak out.
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Choose the Quick Settings toggle option from the menu to
the right of the Taskbar.

Next, click the right-pointing arrowhead next to the Wi-Fi
symbol in the top section of the quick settings box.



Manage Wi-Fi connections
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The "More Wi-Fi options" option at the bottom of the "Wi-Fi
box," which shows a list of available Wi-Fi networks, should
be selected if Wi-Fi is enabled.
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More Wi-Fi settings

Choose 'Manage recognized networks' under the Wi-Fi
section of the 'Network & internet' settings screen.
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‘ - - Network & internet > Wi-Fi

All previously stored wireless networks are listed on the
screen. Click the 'Add Network' button located on the 'Add a
new network' row at the top of this list.
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To manually add a
wireless network, a box that looks like the one on the control
panel will appear. This box asks for the same information as
the last one, while having a slightly different look.

Enter the Network Name, Security Type, and Security Key as
required. If you would want to connect to the chosen WiFi
network automatically, check the box next to "Connect
automatically.”

Add a new network
ilcom D\

Network name

) No, kiya.

Security type

WPA2-Personal AES
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Once finished, press the 'Save' button.



Known networks
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You may now see the new network listed among your saved
and accessible networks. You will also automatically connect
to this wireless network until you modify your settings.
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Connect to a Hidden WiFi
Network Manually from
the Control Panel

Alternatively, you may manually establish a WiFi
connection from your PC's Control Panel.



In the taskbar's search box, enter "Control Panel" after
clicking the "Search" button. To access the control panel,
either click the "Open" option located under the app icon on
the right, or pick the name of the program located below the
"Best Match" area on the left.

Click the 'Network and Internet' button on the 'Control Panel
window.

Choose 'Network and Sharing Center' from the 'Network and
Internet' screen that displays.



Just underneath the 'Change your networking options' area
on the 'Network and Sharing Center' page, choose 'Set up a
new connection or network".



Click 'Next' after choosing 'Manually connect to a wireless
network' from the pop-up window.
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Enter information for the wireless network you want to add

Now you'll need to input the network name and the network
security key or password, security type, and encryption type
(if applicable) for the connection you want to manually
connect to.

After supplying the required information, check the box
labeled "Start this connection automatically." When the
procedure is complete, you will be instantly connected to
this network by performing this. Hit the "Next" option on the
menu.



Successfully added No, kiya

The list will be updated with the newly added wifi network.
To continue, choose 'Change connection settings' from the
next pop-up.

—> Change connection settings




No, kiya. Wireless Network Properties X
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Now, a box on the screen with the name "Wireless Network
Properties" will provide the information for the newly
established wireless network. Since this network is set up to
start automatically, the 'Connect automatically when this
network is in range' option will likewise be pre-selected.
Click the "OK" button to proceed.
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Click the Wi-Fi button to reactivate it if it was previously off.
The wireless network that you manually established will now



be linked to you automatically.

On Windows 11, how to
Forget 2 Wireless
Network/Wi-Fi Connection

Sometimes we all want to forget things. Forgetting a Wi-Fi
connection is easy, but what occurs in the mind stays there
and cannot be changed.

The steps outlined in the preceding section apply to
forgetting a wireless network as well. Click the Quick
Settings toggle in the Taskbar, followed by the > forward
arrow symbol and the '‘More Wi-Fi Settings' option located at
the bottom of the box. Next, go to the Wireless Settings
page and select the 'Manage recognized networks' option.



* > Wi-Fi > Manage known networks

Known networks

work " Preference ter by All

Add a new network Add network

9

)]

On the 'Manage known networks' screen, go to the Wi-Fi
connection that you want to delete from your system's
memory. Click the 'Forget' button next to that network.
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More Wi-Fi settings

In the quick settings, you can also delete the WiFi network
from the list of WiFi connections. To erase a WiFi connection,
right-click or touch on it, then choose 'Forget' from the drop-
down menu.



Your connection to that wireless network has been lost! It
would vanish from your Ilist of WiFi connections or
recognized networks.

Can't connect to WIiFiI on
Windows 11?

Your WiFi may not be functioning for a variety of reasons. It
could provide weaker signals, stop functioning entirely, or
prevent your computer from connecting to WiFi in the midst.
These troubleshooting methods should fix your weak wifi
connection, whatever the problem may be.

First and foremost, establish a relationship. You could not
get complete wireless connection if your WiFi router is too
far away from your PC. Try moving your computer's WiFi
connection closer to the router and see if it helps. If it gets
better, the distance between your system and the WiFi
router or source was most likely the issue.

Examine the WIiFi router directly if it doesn't resolve the
issue. Turn off the WiFi router by unplugging it. Connect the
router back after a few minutes. Check your computer's and
the router's WiFi connections. Restart the router or reset it if
needed if the issue continues. Next, try to get your device to
connect to WiFi.
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Fix 1: Reset your



computer's network.

You may reset your Windows 11 device's WiFi network
adapter if none of the other solutions work.

Click the Windows key + X to launch the Settings menu, and
choose the 'Settings' option.

From the Settings app, choose 'Network and Internet' from

the left panel of choices. Click 'Advanced Network Settings'
at the bottom of the 'Network and Internet' settings page.

# Network & internet
0 Busicoth & dece 2 Aiplane moce

To access "Advanced Network Settings," go to "More
Settings" and then "Network Reset."

Network & internet » Advanced network settings

Select the 'Reset Now' button located at the far right of the
'‘Network Reset' option on the 'Network Reset' screen.



Network & internet > Advanced network settings * Network reset
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The next prompt will appear; click 'Yes' to accept it.



Network reset

Are you sure you want to reset your network settings?

To reset the network, you must first log out of WiFi. All
stored WiFi passwords will thus be removed. Your Windows
11 machine will shut down automatically once you've
rebooted the network. Another option is to manually shut
down your machine.

You're about to be signed out

Windows will shut down in 5 minutes.

Shutdown will start on Saturday, July 10, 2021 12:14:29 PM.

Close |

There is no "WiFi" option in the quick settings box, and the
"Wifi" symbol on the taskbar has been replaced with a
disconnected globe icon. We are presently in the process of
wiping the WiFi.



The WIiFi button in the quick settings will return once you
restart your computer. Reconnecting to the WiFi network is
necessary.

Click the fast settings box located in the taskbar's lower
right corner to get started.

Next, click the arrow next to the WiFi indication on the right.
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After choosing the desired wireless network to rejoin to,
enter the WiFi password or network security key. Press the
'‘Next' button once you're done.

Secured

Enter the network security key

Next Cancel
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More Wi-Fi settings

Now, you may reconnect to the WiFi network. Nevertheless,
this technique is limited to fixing WiFi connection problems
with the Windows 11 operating system. Any other technical
problems causing the WiFi disconnection would remain
unresolved. The techniques provided below could be helpful.



Fix 2. Update the Wireless
Network Adapter Driver.

I

gl mzecmwmr Your Windows 11 device
may have a poor wifi connection if the system's wireless
drivers are outdated. You may be able to get the WiFi
working normally again after updating these drivers. Here's
how you go about it.

Click the "Search" button on the taskbar (the magnifying
glass symbol) and type "Control Panel" into the search box.
To launch the Control Panel, click the program name found
in the search results or the "Open" button located to the
right of the search results.

Click on the Control Panel and choose "Hardware and
Sound".
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Select the 'Device Manager' option located under the
'‘Device and Printers' menu option, when the Hardware and
Sound page appears.

Navigate to the "Network Adapters" section of the Device
Manager page to expand this option. The name of your
wireless adapter is the second option under "Network
adapters.” Double-click it.
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Your wireless adapter's properties will now show the 'Driver’
tab. Select the 'Update Driver' button located under this tab.

You will now be given the option to choose the method of
searching for driver updates. Please tick the box next to

"Search automatically for drivers" to begin an automated
search.
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Choose the option to 'Search for updated drivers on
Windows Update' if the driver updates for your wireless
device are not shown in the ensuing window.

The best drivers for your device are already installed

Windows has determined that the best driver for this device is already installed. There ma y be
better drivers on Windows Update or on the device manufacturer's website.

:a Qualcomm QCAS3TT B02.11ac Wireless Adapter

The 'Windows Update' setup page will be shown to you. If
there are any updates, they will be shared here.

Click the 'Install Now' button above the list of pending
installs to begin installing the pending updates.
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After the updates have been installed, restart your device
and check your WiFi connection.

3. Execute WLAN Auto-
Configuration

In the event that all else fails, you may set up your system's
wireless LAN connection to continuously look for wireless
networks that are accessible to connect to and connect you
when one does.
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Enter "run" into the search field, then choose "Run" from the
list of results on the left or "Open" from the menu below the
app name on the right to start the "Run" program. Another
way to launch this application is to hit Windows Key + R.

Type the name of a program, fpier, document, or
| —
E=J  Intemet resource, and J\is@Bws will open it for you

services.msc

Cancel

Press the 'OK' button after entering services.msc in the
'‘Open' box of the 'Run' dialog box.
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You'll get a list of every service that is active on your system
right now. Navigate to the 'W' section located below the
alphabetized list of services.

Locate the service known as "WLAN AutoConfig". In the
event that the service indicates "Running," there isn't a fix
for your WiFi issue here. But if it indicates something other
than "Running," like "Disabled," double-click the WLAN
AutoConfig option to open it.

The WLAN AutoConfig properties dialog will appear; stay on
the 'General' tab.
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The 'Startup Type' option is selected. After choosing
'‘Automatic' from the drop-down option, click 'Apply'.
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Click 'Start' to start the service in the same dialog box, then
click 'OK' to confirm. 'Running' is the new status for the
service.

Note: Your WiFi will automatically shut down if WLAN
AutoConfig is not functioning. This will function as a prompt



to verify these settings once again.

Verify the WIiFi connection on your device once the WLAN
AutoConfig service has started.



HOW TO MAKE EVERYTHING IN
WINDOWS 11 SMALLER

Here's how to reduce the size of your Windows user
interface if you feel that it's too large.

You may make your computer simpler to view and operate
by lowering the size of text, icons, and other elements if you
feel that everything on Windows 11 is too huge. To make
sure that Ul components (text, icons, taskbar, and other
things) are legible and the right size, Windows automatically
detects and modifies display settings depending on screen
size and resolution.

But it doesn't always function. You may have to manually
alter the settings in order to match your display settings to
the real screen size. To prevent eye strain, users with
smaller screens or lower resolutions will need to manually
decrease the size of everything. Furthermore, if you are
using an app that occupies too much screen real estate,
lowering the scale may help make things simpler to view
and utilize.

This section will examine several approaches to reduce the
size of all Windows 11 Ul components, including fonts and
icons.

To reduce the size of
everything, modify the
display scaling in Windows
11.
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The number of
individual pixels that may fit into a one-inch line on a display
is known as the DPI (Dots Per Inch) scaling. You may use it
to change the size of programs, text, icons, and other user
interface components on your screen. Everything seems
bigger when the DPI level is greater, and everything
appears smaller when it is lower. In Windows Settings,
change the display scale to make the typeface, program,
and other elements smaller.

Select 'Display settings' from the context menu by right-
clicking anywhere on your desktop.



Alternatively, press Windows+| to open the Settings app,
then choose 'Display' from the System tab.

Q oy P System > Display

Brigharsas & cobr

Navigate to the 'Scale & layout' section and choose 'Scale’

from the dropdown menu when the Display options panel
appears.



a - System > Display

Brighteoss & colar

From the list of scaling possibilities, choose the lowest

percentage that best meets your demands, such 125% or
100%.

u System > Display

Scale & layout

= e B  Display orientation Landscape
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The typeface, icons, and user interface components will all
go smaller when you choose this option. There are just four



percentage possibilities available in the drop-down list: 100,
125, 150, and 175 percent.

You may adjust the display scale if you're not happy with the
preset settings. Instead of using the drop-down list, use the
Scale option to alter the scaling size.

|£2 ) System > Display > Custom scaling

Type a custom scaling size value between 100% and 500%
in the text area, then click the Check button.

-k.,j — - System > Display > Custom scaling

Then sign out of your PC to apply the scaling level.



Change the height of the
taskbar and the size of the
icons in Windows 11.

If all you want to do is adjust the taskbar's and its icons'
sizes, then follow these instructions. You have to use the
Registry Editor to make the taskbar and its icons smaller
since there is no natural method to adjust the taskbar
height and icon size.



=l Run X

Type the name of a program, folder, document, or
=/ Internet resource, and Windows will open it for you.

Open: I ‘regediﬂ i v
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Start Windows Registry Editor by using Win+R, entering
"regedit," and selecting "OK."

When the Registry Editor opens, go to the location below or
copy and paste the path below into the Registry Editor's
address bar and click Enter.

\sHKEY CURRENT
USER\Software\Microsoft\Windows\CurrentVersion\Explorer\A
dvanced should be entered.

Go to the Advanced folder and look for the REG DWORD
TaskbarSi. You have to make it if it doesn't already exist.

To access DWORD (32-bit) Value, right-click the "Advanced"



key, choose "New," and then "Value." As an alternative, you
may choose 'New' > 'DWORD (32-bit) Value' by right-
clicking on any empty area in the right pane.

Next, give the newly created registry item TaskbarSi a new
name.




Next, double-click "TaskbarSi" and choose one of the
following values for its Value data:

0 - Small size
1 - Medium Size (Default)
2 - Larger Size

Edit DWORD (32-bit) Value X
Value name:
Taskbarsi y.
Value data: Base
I : | OHexadecimaI
() Decimal
OK ] Cancel

To make the taskbar smaller, change the number to 0 and
click "OK".

Once the Registry Editor has been closed, restart your
computer. You'll notice that the taskbar and icon sizes have
changed when the machine boots up.

Before: After:
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You may reduce the size of everything by using an AMD or
NVIDIA display panel.

Using AMD or NVIDIA panels to adjust Windows display
settings is another option to modify the size of Windows
icons. Here's how you go about it:

Using the right-click menu, choose 'Show additional options'
to open the Control Panel for AMD or NVIDIA graphics cards.

AMD Radeon Software

AMD Link For Windows
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Click on 'AMD Radeon Software'. Choose 'NVIDIA Control
Panel' if your graphics card is an AMD graphics card by
default.

Locate the 'Scaling Mode' option by navigating to the
'‘Display' settings in the Graphics control panel. From the
drop-down option, choose 'Full panel'.

Restarting your computer will then cause the adjustments to
take effect.



In Windows 11, you can make icons smaller without
scaling them.

You must use keyboard shortcuts, context menus, or mouse
scroll to adjust the size of your Windows icons (desktop, File
Explorer, and taskbar icons) without modifying the
resolution or scale.

Decrease the size of desktop icons

In Windows 11, you may manually adjust the size of desktop
icons by performing a right-click on an empty spot on the
desktop. Next, choose 'Small icons' from the sub-menu and
'View' from the context menu.

Alternatively, you may use the Ctrl key to hold down and
scroll up or down to adjust the size of your icons. You may
also use the shortcut key Ctrl+Shift+4 to make the icons
smaller.




Shrink the File Explorer icons in size.

Using the same procedure as on the desktop, you
reduce the size of the file explorer icons.

Right-click in the File Explorer on an empty spot,
choose 'View' from the sub-menu.
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& Settings

Vision

Text in Windows 11 can be
made smaller.

If all you want to do is reduce the text's size without altering
the size of other Ul components, you shouldn't adjust the
scale settings. Use these procedures to modify the font size:

You may enter Windows Settings by pressing Windows+lI.
Next, choose "Text size" on the right after selecting
"Accessibility" on the left.



@ g Accessibility > Text size

Text size preview

Use the slider next to 'Text size' to shrink the text if it has
been altered or if it is too big for your machine. A preview of
the size change will show up above as you adjust the slider.
Press 'Apply' to ensure that your changes are saved.

To make things smaller on your screen, adjust the
resolution.

The number of unique pixels that may be seen on the
screen in each dimension—horizontally and vertically—is
known as the screen resolution. Images on tiny displays,
such as tablets or mobile phones, are crisper and more
vibrant because smaller screens have a greater pixel
density (the number of pixels per inch) than bigger panels.

Increasing the screen resolution will make items smaller if
your display is operating at a lower resolution than the
maximum resolution of your monitor. Because a higher
resolution increases the number of pixels on the screen,
visuals become more crisp and clear. With increasing
resolution, the picture and other components become
smaller. The resolution decreases with increasing picture
and other Ul element size. Here's how to adjust your
Windows 11 computer's resolution:
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To adjust the display resolution, right-click anywhere on your
desktop and choose 'Display settings'.
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This will open the Display options in the options app. In the

'‘Display resolution' tile, under Scale & layout, choose the
drop-down menu.
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In addition to the current resolution in the drop-down menu,
you'll see a list of resolutions that your monitor supports.
Select the maximum resolution available to reduce the size
of all icons, text, and other elements (Recommended

resolution).

Keep these display settings?

Ravarting to provious displey settings in 11 seconds.

Click the 'Keep changes' button on the popup before the
timer goes off.

Upon changing the resolution, you will see a shift in size.

That's it. With Windows 11, you may effortlessly change the
size of any element on your screen by using the previously



mentioned techniques.



HOW TO ENABLE BLUETOOTH IN
WINDOWS 11

For wirelessly connecting accessories to your Windows 11
PC, such as mice, keyboards, controllers, headsets, and
other devices, Bluetooth is perfect. Here's how to turn it on
and make your very first connection.

In Windows 11, Bluetooth may be activated either the

Windows Settings app or the Quick Settings menu. We'll
cover both options and some fundamental troubleshooting

below.

Alzpw| ™M)
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Using the Quick Settings
Menu, enable Bluetooth.

In Windows 11, the simplest method to activate Bluetooth is
via the Quick Settings menu. Click the group of indicator
icons on your taskbar, directly to the left of the time and
date, to get access to it.

This secret button will cause the Quick Settings menu to
appear. The Bluetooth symbol is a stylized "B" with sharp
angles; choose it.
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(Click the pencil symbol in Quick Settings if the Bluetooth
button or icon is not visible. Next, click "Add," and choose
"Bluetooth" from the drop-down option.)

The button changes color and turns on Bluetooth when you
click. To establish a connection, right-click the Bluetooth
icon and choose "Go to Settings".
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Proceed to the section below, labeled "Adding a Bluetooth
Device to Windows 11," after that.

Get Bluetooth working in Windows Settings.

You may also turn on Bluetooth in Windows Settings. To
launch Settings, either type "settings" into the Start menu
or press Windows+i on your keyboard.
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Click "Bluetooth & Devices" in the sidebar of Settings.
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In the Bluetooth settings, flip the switch next to "Bluetooth"
to the "On" position.
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Add device
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It's now time for you to establish your first connection.
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How to Add a BIuetootH
Device to Windows 11

Now that you've located Settings > Bluetooth & Devices
(using any of the two sections above), it's time to pair a
Bluetooth device with your Windows 11 PC.

Click the large "Add Device" button with a plus sign ("+") at
the top of the Settings window, under the "Bluetooth &

Devices" section.




Add a device

Choose the kind of device you want to add

* Bluetooth
Mice, keyboards, pens, audio devices, controllers, and more *

ces |

g Wireless display or dock
Wireless monitors, TVs, or PCs that use Miracast, or wireless docks

| Everything else

Xbox controllers with Xbox Wireless Adapter, DLNA, and other devices

In the "Add a Device" box that shows up, click "Bluetooth".

Add a device

Add a device

Make sure your device is turned on and discoverable, Select a device below to
— connect.

O Microsoft Sculpt Comfort Mouse é
nput

Ices

e Next,
confirm that the device you're trying to connect to is in

pairing mode and has been switched on. See the guidebook
for instructions on how to do this since the process varies
according on the device.

After switching to discovery mode, Windows will keep
searching for devices that are in pairing mode. They will be
listed in the pop-up window as soon as it discovers them.



Click the name of the device you want to connect to when
you see it in the list.

If it's @ mouse, gaming controller, or headset, it ought to
connect on its own. If Windows 11 detects a keyboard, it can
ask you for a passcode. If that is the case, input that
passcode into the Bluetooth keyboard that you are trying to
link.



Your device is ready to go!

O M ft Sculpt Comfort Mouse

)

When you get the notification "Your device is ready to go,"
your PC and Bluetooth device are linked. Choose "Done."

After that, all you need to do is close Settings and get going.

It is important to remember that once you couple Bluetooth
devices with Windows 11, they stay paired with your
computer until you pair them with another computer,
smartphone, or tablet. This suggests that using vyour
Bluetooth device shouldn't need linking it each time.

To save battery life, the majority of Bluetooth devices shut
down automatically after a certain amount of time. If the
Bluetooth device has a power button, use it to switch on and
reconnect with your PC right away. If not, hit a button on a
keyboard or mouse to continue where you left off.



RUNNING ANDROID APPS

The Windows Subsystem for Android platform in Windows 11
allows you to run Windows applications alongside Android
apps on your laptop or desktop. Even if you can only install
applications from the Amazon Appstore, you can still
sideload Android apps using the Android Debugging Bridge
(ADB) tools.

For devices running the latest version of Windows 11 and
the Microsoft Store app, the platform is now in preview
mode. The platform is now available in 31 more regions,
including Canada, Australia, France, Italy, Germany, Spain,
and the UK. Previously, it was only available in the US and
Japan.

You will be walked through the necessary procedures in this
part to begin downloading and using Android applications on
Windows 11.

A Guide to Installing Windows Subsystems on Windows 11

First, you need to make sure your computer meets all the
requirements.

System requirements

The following prerequisites must be met in order to install
Android applications on Windows 11:

8GB RAM is the minimum; 16GB is recommended.

AMD Ryzen 3000, Intel Core i3 8th Gen, Qualcomm
Snapdragon 8c, or a similar CPU.

SSD stands for solid-state disk.

The Microsoft Store app must be used with at least version
22110.1402.6.0.



It must be Windows 11 with version 22000.526 or above.
Assess the system requirements.

Use these procedures to verify the system requirements: Go
to the option that says Settings.

Choose a System.
Navigate to the "About" page on the right.

Verify the CPU and RAM specifications in the "Device specs”
section.

Verify that the build number in the "Windows specs" section
equals or exceeds 22000.526.

System Selection.
Navigate to the Storage page on the right.

From the "Storage management" section, choose "Advanced
storage settings".

Click on the Disks & volumes menu.
Press the Properties button after selecting the main drive.

Verify that the SSD is the kind of media. (If the label reads
"HDD," WSA cannot be installed.)

After completing the procedures, check for updates to
ensure the system has the most current patches and the
most recent version of the Microsoft Store.

Checking for Windows 11
updates

To download and install updates for Windows 11, adhere to
following instructions:

Open the Settings.
Click on Windows Update.
From the menu, choose "Check for updates".



When the process of installing the system updates is
complete, restart the computer.

Check for Microsoft Store
update

To download the Amazon Appstore app, the computer also
needs to have the most current version of the Microsoft
Store software installed.

To confirm the Microsoft Store version and to get updates,
follow these steps:

Open the Microsoft Store application.

Choose Library.

Click on the "Get updates" option.

From the Profile menu, choose App settings.

Make sure the version matches or exceeds 22110.1402.6.0.

You may use Windows 11 and the UEFI firmware to enable
virtualization when you've finished the necessary steps.

Allow virtualization

The Windows Subsystem for Android also needs
virtualization to be enabled at both the hardware and
software layers in order to run the virtual computer that
powers everything. For information, see the support page of
your device's manufacturer since these procedures differ
based on the product. On a PC equipped with modern
hardware, this feature could already be enabled. You may
activate Windows 11l's "Virtual Machine Platform" feature
after you've enabled virtualization.



To make Windows 11's Virtual Machine Platform functioning,
adhere to following instructions:

Launch the software.

Click the first result after searching for "Turn Windows
features on or off" to launch the experience.

From the drop-down option, choose "Virtual Machine
Platform".

Press the OK button.




Choose the option to restart.

After the processes are finished, you may install the Amazon
Appstore and the Windows Subsystem for Android.

Install the Windows subsystem for Android.

Installing the Windows Subsystem for Android and the
Amazon Appstore together may be done by following these
steps:

R
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Open the Amazon Appstore website in a new tab.

Select the Install option.

Select the Setup option.



Get your PC ready for the Amazon

Select the Download option.



Click the button after that.
Choose the option to restart.

You may install Android applications on Windows 11 after
the steps are finished.



INSTALLING ANDROID APPS ON
WINDOWS 11

Use these guidelines to set up Android applications on your
PC:

I - —m |

Start the program.

Choose the top result from the search for Amazon Appstore
to open the app.

Click the Sign in button to log in.

Use your Amazon account to log in.
Select a program.
Click the "Get" option.

Click on the "Download" option.



Again, click the Download button.

After following the steps, you may open the app from the
Start menu or the Amazon Appstore. It's most likely in the
"All apps" area if you can't locate it.

An Android app operates just like a regular Microsoft Store
app when you launch it. Input may be done using the mouse
and keyboard, and windows can be enlarged, maximized,
and minimized. Like any other software, you may end the
application by clicking the Close button, however it can take
some time.



HOW TO REMOVE ANDROID
APPS FROM WINDOWS 11

In Windows 11, Android applications may be removed from
the Start menu or Settings app, just like any other Microsoft
Store product.

Take the apps off of the Start menu.

To remove Android applications from the Windows 11 Start
menu, do these steps:

Launch the software.
Seek out the application.
Right-click the Android applications to uninstall them.
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Take the apps out of the Settings.

To remove Android applications from the Settings app, follow
these steps:




Go to the option that says Settings.
Choose Applications.

Go to the Installed applications page from the right side
menu.

Choose the Android app.

From the menu, choose the Uninstall option by clicking the
three-dotted button.

Press the Uninstall button again.

Once you've finished the instructions, the app won't be
accessible on the smartphone.

These instructions are applicable to sideloading applications
using the Android Debugging Bridge (ADB) tools as well as
removing apps from the Amazon Appstore.



DIRECTIONS FOR REMOVING
THE ANDROID WINDOWS
SUBSYSTEM FROM WINDOWS
11

Follow these instructions to delete the Windows Subsystem
for Android, Amazon Appstore, and installed apps:

Go to the option that says Settings.
Choose Applications.
Go to the Apps & Features page from the right side menu.

Select the program "Windows Subsystem for Android".

From the menu, choose the Uninstall option by clicking the
three-dotted button.

Press the Uninstall button again.
Restart the computer.



Just a friendly reminder: Although you don't have to restart
the system, it may need to be refreshed in order to remove
any residual configuration and data. Additionally, you can

run into trouble getting the necessary files from the
Microsoft Store if you don't restart the platform after
reinstalling it.

After the procedures are finished, the Windows Subsystem
for Android, the Amazon Appstore, and Android applications
will be removed from the device.

Additional information

Though the platform works well straight out of the box, the
Windows Subsystem for Android provides a variety of
options that may be accessed via the Start menu.




On the settings page, you could notice items generated or
downloaded using the platform, such as documents, music,
video, images, and more.

By default, WSA won't do anything until you launch an
application. On the other hand, a feature called "Subsystem
resources" on the settings page gives you the option of
running the virtual machine continuously or not.

The "Graphics and Performance" function also allows you to
choose the graphic card the platform uses to run
applications.

In the "Developer" area, you may activate "Developer
mode" for testing and troubleshooting.



There are many shims under the "Compatibility" area that
may be activated for individual applications to improve the
compatibility of Android apps with

Windows 11.

While it's a positive development that Windows 11 now
supports Android apps, you still can't run any program you
want. Consider the mere 20,000 or so applications available
in the Amazon Appstore. Though it may seem like a lot, the
most are games, so it's not really that many. Additionally,
although you may be able to sideload programs, other apps
—Ilike Gmail, Google Maps, and others—won't work if they
need Google Play Services.

In this section, we installed WSA via the

Amazon Appstore; however, you may alternatively use the
Windows Subsystem for Android app (opens in new tab),
which installs the Amazon Appstore.

The platform is only available in a few countries. If your
nation is still not supported, you may get around this by
adjusting the region settings. Under Settings > Time &
language > Language & region, change the "Country or
region" option to the United States.




Microsoft has released several tools (opens in new tab) for
developers to help them optimize Android applications for
the Windows Subsystem for Android.

The process of establishing the platform settings and setting
up the development environment is walked through in the
documentation. You will also find details on resizing
windows, adding keyboard and mouse functionality, and
learning more about the virtual machine, security, and
Amazon Appstore.



COMMON WINDOWS 11
PROBLEMS

Like every previous iteration of Microsoft's legendary
operating system, Windows 11 contains a number of
persistent bugs. others of the issues are small annoyances,
but others may really ruin the experience.

Either way, certain problems are more common than others.
You could have problems with audio, network connection,
battery life, display, and other parts in addition to Windows
11 system requirements.

To help you make the most of the best Windows OS version
to date, we've put together a list of common Windows 11
issues along with their fixes.

1. Inability to upgrade
from Windows 10 to
Windows 11

Windows 11, which brings much-needed visual
improvements, lacks several security measures as well.
Many competent but older PCs were left out of the upgrade
queue when the OS was originally released.

Windows 11 may only be installed on systems that are
compatible with Secure Boot and TMP 2.0. The complete list
of system requirements for Windows 11 can be seen here.
You won't be able to update without difficulty otherwise.

For Windows-based computers, there's always a
workaround, however. An unsupported Windows 11 PC may
be made compatible with a registry change. There is a



catch, however. If you install Windows 11 on an
inappropriate PC, you may not be able to get updates
automatically. Because Windows 10 won't get security
updates until late 2025, behave with care.

2. Unable to Install
Windows 11 Updates

It is possible for Windows to fail to install updates on
computers that are compatible with Windows 11,
notwithstanding this. This will prevent you from being able
to install the most recent build of Windows 11 OS.

Troubleshoot sound problems

~

{8 Open volume mixer

{82 Sound settings

245 PM
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The update
problem might also be caused by a faulty software
distribution folder or a lack of storage space.

3. No Sound Issues In
Windows 11



The main cause of Windows 11's audio deficiency is external
sources. On your Windows 11 PC, you could sometimes
encounter poor audio as well. Incorrectly setup playback
devices are a common source of audio issues.

Make sure any installed audio tuning software is configured
to utilize your default sound device. Restart the Windows
audio services and use the Windows audio troubleshooter to
fix any problems.

Take these actions to launch the audio troubleshooter:
Right-click on the speaker icon in the Taskbar.
Select Troubleshoot Audio Problems.

To implement the recommended modifications, adhere to
the on-screen instructions.

See our guide on fixing Bluetooth audio not functioning on
Windows 11 if you're experiencing issues with Bluetooth.

4. The Windows 11 Start
Menu Is Inoperable

The default orientation of the Start menu has been moved
to the middle of your screen in Windows 11. This makes
aesthetic and functional sense for most people. Additionally,
compared to its predecessor, it seems more polished and
new overall.



Personalization > Taskbar

You may adjust the
Start menu in Wlndows 11 to bring back the conventional
left-side arrangement if you like it. Here's how you go about
it.:

To access Settings, just hit Win + .

Go to the Taskbar after selecting the Personalization option.

Expand the Task Behaviors section, then choose Left from
the drop-down selection for Taskbar Alignment.

The Start menu is still prone to mistakes, however. One
common issue is that the Start menu icons are missing. The
critical error in the Start menu may then appear. Often,
these issues are the result of a brief conflict between third-
party applications and the Start menu services, which may
be swiftly resolved.



5. Windows 11 File
Explorer Not Working

There has
been a File Explorer since Windows 95. It's a very practical
file manager that simplifies the process of accessing the file
directories on your computer. With Windows 11, Microsoft
has made improvements to the venerable file manager.

You are able to multitask by using several tabs in Windows
11 File Explorer with the latest 22H2 version. Among other
things, you may alter the folder and file icons in File Explorer
to further customize it.

Any problems with File Explorer may be fixed with a restart.
Restart the File Explorer process in Task Manager to fix the
problem:

When you right-click on Start, a context menu will appear;
choose Task Manager.

Choose to restart Windows Explorer by doing a right-click.

If so, continue reading for further solutions to Windows File
Explorer not opening.



6. Fixing Windows 1l's
Slow Performance

64GB of storage
and 4GB of RAM are needed to install Windows 11.
Nonetheless, you will want a least of 8GB of RAM and ideally
a 128GB SSD boot drive for seamless daily operation.

There are occasions when Windows 11 performance
problems affect even the most powerful computers.

Ensure that unnecessary startup programs are turned off in
Task Manager if a sluggish starting is the reason for the
performance problem. To make this happen:

When you right-click on Start, a context menu will appear;
choose Task Manager.

Open Task Manager and choose the Startup Apps tab.
One by one, choose each worthless app and disable it.

If you find that excessive disk utilization is causing your
system to crash, check out our guide on how to fix 100%
disk usage on Windows 11.

Performance issues may probably be fixed by modifying
system settings and looking into internal causes. In rare



instances, a hardware update could be necessary to
enhance system performance.

7. Wi-FIi and Ethernet
Connectivity Issues with
Windows 11

Network connection is another issue that Windows 11 may
present for you. Whether you are using a cable or wireless
connection, there are a number of reasons why network
issues might arise.

If your Internet connection stops working for no apparent
reason in Windows 11, you may want to try a network reset.
It may also help you fix your Windows 11 computer's
missing Wi-Fi option.

To accomplish this:
To access Settings, just hit Win + I.

To access the Advanced network options, first choose the
Network & internet tab.

@ — Network & internet > Advanced network settings




After swiping to the bottom, choose Network reset.
Now click Reset to complete the operation.

8. Flashing, Flickering,
Blurry, and Black Screen
Issues in Windows 11

Windows 11 comes with a Microsoft Basic Display Adapter
pre-installed. It's a generic display driver that helps with
setup and lets you use your display after a clean install.

Installing all outstanding Windows updates should ideally
happen after a fresh install or on the first boot of your newly
acquired computer. This might help you fix problems with
fuzzy screens and display quality on a brand-new or newly
configured system. To install updates for Windows, use
these steps:

e To access Settings, just hit Win + 1.

e Click the Windows Updates tab in the left pane.

e Choose Check for updates after that. Prior to
restarting your computer, download and install any
outstanding updates, if they are available.

e Update your Windows GPU driver if the issue
continues. The flashing and flickering screen on
your computer should go away after installing the
necessary drivers.

If you are seeing a black screen, you may want to try a
Windows 11 repair installation. It could be necessary to do a



reset or fresh install if that doesn't work and there isn't a
hardware issue.

9. Turning Off Bing Web
Search in Windows 11

The built-in Windows Search bar may be used to locate files
and folders with ease. However, it goes well beyond what
the user requested. Windows Search defaults to displaying
matching Bing search phrases.

Microsoft's search engine marketing cannot be configured to
show results from other search engines, including Google,
despite the fact that it may seem like a useful feature.

Moreover, this might prevent the search dialog from
opening by displaying pointless info. Thankfully, Bing web
searches may be prevented on Windows 11 with a registry
modification.

10. Turn Off Ads on Your
Windows 11 Device

Portable Windows 11 devices are commonly observed to
contain bloatware from the vendor. It's possible that your
Windows 11 Start menu contains some useless program
suggestions in addition.

There are even more subdued ways to advertise. It's
possible for notifications, the start menu, File Explorer, and
use advice to all contain advertisements. Thankfully, turning
off the majority of these advertisements is easy.



11. Turn off Windows 11's
automatic updates.

Windows 11 automatically downloads essential updates to
keep your machine up to date with the newest security
patches and performance enhancements. Some changes,
meanwhile, can make matters worse rather than better.

You can turn off automatic updates in Windows 11 if you'd
like to install updates one by one. One method is to use
UpdateBlocker, a third-party tool. To enable this to occur:

e Visit the Windows Update Blocker page to get the
Windows Update Blocker application.

e Launch the tool, then select Disable updates.

e Click Apply Now and restart your computer to apply
the changes.

Suggested Troubleshooting Steps for Windows 11

These are some of the typical problems with Windows 11
that you can run into after setting up the newest software
from Microsoft on your system. Even though a flawless
Windows OS is ideal, you can handle most of these issues on
your own. To find more in-depth answers to the current
topic, click on the links provided within the article.



CONCLUSION

Finally, upgrading is logically justified.

Since its release more than a year ago, Windows 11 has
seen a steady increase in use. By December 2022, it
accounted for almost 17% of the worldwide Windows
installation market. It will take several years for Windows 11
to surpass long-standing favorites like Windows 7, even with
a 1% increase in share per month, since it still lags well
behind Windows 10's 68% market share.

Anyone thinking about updating to Windows 11 should do so
since it's a good upgrade. Numerous early flaws have been
resolved by Microsoft, and the Windows 11 2022 Update
demonstrates the company's commitment to continuously
improving the platform for all users while also taking early
adopters' opinions into consideration. There's also a free
Windows 11 update available.

Don't panic if you can't update to Windows 11 just now.
Since Windows 10 will be maintained until 2025 and
features from Windows 11, such as the redesigned Microsoft
Store, are already being rolled down to Windows 10, you
have plenty of time to move.
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